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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using the printer. Also, be sure to follow 
all warnings and instructions marked on the printer.

Setting Up the Printer

Observe the following when setting up the printer:

❏ Do not block or cover the vents and openings in the printer.

❏ Use only the type of power source indicated on the printer’s label.

❏ Use only the power cord that comes with the printer. Use of another cord may result in 
fire or electric shock.

❏ The printer’s power cord is for use with the printer only. Use with other equipment may 
result in fire or electric shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that 
regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or the base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that the total ampere rating of 
the devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure that the total ampere rating of all devices plugged into the wall outlet 
does not exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the printer yourself.
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❏ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions: 
The power cord or plug is damaged; liquid has entered the printer; the printer has been 
dropped or the casing damaged; the printer does not operate normally or exhibits a 
distinct change in performance.

❏ When connecting the printer to a computer or other device with a cable, ensure the 
correct orientation of the connectors. Each connector has only one correct orientation. 
Inserting a connector in the wrong orientation may damage both devices connected by 
the cable.

❏ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If 
there are fuses in the plug, make sure you replace them with fuses of the correct size 
and rating.

❏ Do not hold the duplex unit when you lift the printer to prevent the duplex unit from 
becoming detached. Also, make sure that the duplex unit is attached correctly after 
setting up the printer.

Choosing a Place for the Printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond the base of the printer in 
all directions. If you place the printer by the wall, leave at least 4 inches (10 cm) 
between the back of the printer and the wall. The printer will not operate properly if it is 
tilted at an angle.

❏ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside 
down. Otherwise, ink may leak from the ink packs.

❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the 
printer away from direct sunlight, strong light, or heat sources.

❏ Avoid places subject to dust, shocks, or vibrations.

❏ Leave enough room around the printer to allow for sufficient ventilation.

❏ Place the printer near a wall outlet where the plug can be easily unplugged.
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Using the Printer

Observe the following when using the printer:

❏ Avoid touching the components inside the printer unless instructed to do so in this 
guide.

❏ Do not insert objects through the slots in the printer.

❏ Take care not to spill liquid on the printer.

❏ Do not touch the white flat cable inside the printer.

❏ Do not put your hand inside the printer during printing.

❏ Do not use aerosol products that contain flammable gases inside or around this 
product. Doing so may cause fire.

❏ Do not move the print head by hand; otherwise, you may damage the printer.

❏ Do not move the cartridge lever during printing.

❏ Always turn off the printer using the P Power button. When this button is pressed, the 
P Power light flashes. Do not unplug the printer or turn off the power to the outlet until 
the P Power light stops flashing.

❏ Before transporting the printer, make sure that the print head is in the home (far right) 
position.

❏ Be careful not to trap your fingers when closing the printer cover.

Handling Ink Cartridges

Observe the following when handling ink cartridges:

❏ Keep ink cartridges out of the reach of children and do not drink the ink.

❏ If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.
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❏ Shake the ink cartridge for 5 seconds before installing it for best results.

c
Caution:
Do not shake cartridges (that have been installed previously) with too much force.

❏ Do not use an ink cartridge beyond the date printed on the cartridge carton.

❏ Use up the ink cartridge within six months of installation for best results.

❏ Do not disassemble or modify the ink cartridge. This may affect normal operation and 
printing.

❏ Store ink cartridges in a cool, dark place.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

❏ Do not touch the green IC chip on the side of the cartridge. This may affect normal 
operation and printing. The IC chip on this ink cartridge retains a variety of cartridge 
related-information, such as the ink cartridge status, so that the cartridge may be 
removed and reinserted freely. However, each time the cartridge is inserted, some ink 
is consumed because the printer automatically performs a reliability check. If you 
remove an ink cartridge for later use, protect the ink supply area from dirt and dust, and 
store it in the same environment as this product. Note that there is a valve in the ink 
supply port, making covers or plugs unnecessary, but care is needed to prevent the ink 
from staining items that the cartridge touches. Do not touch the ink supply port or 
surrounding area.
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Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User’s Guide are defined as follows:

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the printer.
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Chapter 1 

Using Your Software

Overview of Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing 
results. Status Monitor and the printer utilities help you check the printer and keep it in top 
operating condition.

Accessing the Printer Driver for Windows

You can access the printer driver from most Windows applications, the Windows Start 
menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver 
from that application.

To make settings that apply to all of your Windows applications, access the printer driver 
from the Start menu or the taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User's Guide are from Windows XP.

From Windows Applications

1. Click Print or Print Setup on the File menu.

2. In the window that appears, click Printer, Setup, Options, Preferences, or 
Properties. (Depending on your application, you may need to click one or a 
combination of these buttons.) 

From the Start Menu

1. Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware 
and Sound category. (If the Control Panel is in Classic View, click Printers.)

Windows XP and Server 2003:
Click Start, Control Panel, then click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then click Printers and Faxes.) 
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Windows 2000:
Click Start, point to Settings, then click Printers.

2. Windows Vista:
Select the printer and then click Select printing preferences.

Windows XP, Server 2003, and 2000:
Select the printer, then click Printing Preferences on the File menu.

From the Shortcut Icon on the Taskbar

Right-click the printer icon on the taskbar, then select Printer Settings.

To add a short cut icon to the Windows taskbar, first access the printer driver from the Start 
menu as described above. Next, click the Maintenance tab, the Speed & Progress 
button, and then the Monitoring Preferences button. In the Monitoring Preferences 
window, select the Select Shortcut Icon check box.

Getting Information through Online Help

You can access online help for items in the printer driver from your application or the 
Windows Start menu.
& See “Accessing the Printer Driver for Windows” on page 14.

In the printer driver window, try one of the following procedures:

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item (for Windows XP 
and 2000 only).

Accessing the Printer Driver for Mac OS X

The table below describes how to access the printer driver dialog.

Dialog How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note for Mac OS X 10.5:
Depending on your application, the Page Setup menu may not 
appear in the File menu.

Print Click Print on the File menu of your application.
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Getting information through online help

Click the  Help button in the Print dialog.

Printing Web Pages to Fit to Your Paper Size

EPSON Web-To-Page™ lets you make Web pages fit to your paper size when printing. 
You can also see a preview before printing.

Note for Windows Users:
This software is not available for Windows Vista and XP x64.

Note for Windows Internet Explorer 7 users:
Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7, so 
EPSON Web-To-Page is not necessary.

Note for Mac OS X users:
❏ This software is not available for Mac OS X.

❏ Printing web pages to fit to your paper size is available by using the printer driver.

EPSON Printer 
Utility3

You can access this software in the following three ways:

❏ Double-click the EPSON Printer Utility3 icon in the Applications 
folder in Macintosh HD. Select the printer from the Printer List, then 
click OK.

❏ Click Print from your application’s File menu, choose Print Settings in 
the Print window that is displayed, then click the  Utility icon. This 
Utility icon is not displayed when the printer is shared.

❏ For Mac OS X 10.3 and 10.4 only
Open the Applications folder on your hard drive, then open the 
Utilities folder and double-click the Print Center or Printer Setup 
Utility icon. Select the appropriate printer from the list, then click the 
Configure or Utility button.
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& See “Printer Settings for Mac OS X 10.5” on page 33.
& See “Printer Settings for Mac OS X 10.3 or 10.4” on page 35.

Accessing EPSON Web-To-Page

After you install EPSON Web-To-Page, the menu bar is displayed on the Windows Internet 
Explorer Toolbar. If it does not appear, select Toolbars from the View menu of Internet 
Explorer, and then select EPSON Web-To-Page.

Uninstalling the Printer Software

Uninstalling the Printer Driver

You may need to uninstall your printer driver if you:

❏ Upgrade your computer’s operating system.

❏ Update your printer driver with a newer version.

❏ Have a problem with the printer driver.

If you are upgrading your operating system or updating the printer driver version, be sure 
to uninstall the current printer driver before upgrading or installing the new driver. 
Otherwise, the driver update will not work.

For Windows

Note:
❏ To uninstall programs in Windows Vista, you need an administrator account and the password 

if you log on as a standard user.

❏ To uninstall programs in Windows XP, you must log on to a Computer Administrator account.
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❏ To uninstall programs in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows Vista:
Click the start button and select Control Panel.

Windows XP and Server 2003:
Click Start and select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

3. Windows Vista:
Click Uninstall a program from the Programs category, and then select EPSON 
Printer Software from the list.

Windows XP and 2000:
Select Add/Remove Programs and then select EPSON Printer Software from the list.

4. Windows Vista:
Click Uninstall/Change.

Windows XP, Server 2003, and 2000:
Click Change/Remove.

5. Select the icon for your printer and click OK.

6. Click OK to uninstall the printer driver.

For Mac OS X

Note:
To uninstall the programs, you must log on to a Computer Administrator account. You cannot 
uninstall programs if you log on as a Limited account user.

1. Quit all running applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.

3. Double-click the Mac OS X icon in the Epson folder. The CD Installer screen is 
displayed. Click Custom Install.

4. Select Printer Driver.

Note:
If the Authenticate dialog appears, enter your password or phrase and click OK.
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5. Read the software license agreement and click Accept.

6. Select Uninstall from the menu in the upper left and click Uninstall.

7. Follow the on-screen instructions to uninstall the printer driver.

Note for Mac OS X 10.3 or 10.4:
If the name of your printer remains in the Print Center or Printer Setup Utility, select the name from 
Printer List and click Delete.

Uninstalling the User’s Guide

For Windows

Note:
❏ To uninstall programs in Windows Vista, you need an administrator account and the password 

if you log on as a standard user.

❏ To uninstall programs in Windows XP, you must log on to a Computer Administrator account.

❏ To uninstall programs in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows Vista:
Click the start button and select Control Panel.

Windows XP and Server 2003:
Click Start, then select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

3. Windows Vista:
Click Uninstall a program from the Programs category.

Windows XP, Server 2003, and 2000:
Select Add or Remove Programs.

4. Select this printer’s Manual from the list.

5. Windows Vista:
Click Uninstall/Change.

Windows XP, Server 2003, and 2000:
Click Change/Remove.
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6. Click OK.

For Mac OS X

Note:
To uninstall the programs, you must log on to a Computer Administrator account. You cannot 
uninstall programs if you log on as a Limited account user.

1. Quit all running applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.

3. Double-click the Mac OS X icon in the Epson folder. The CD Installer screen is 
displayed. Click Custom Install.

4. Select User’s Guide.

5. Select Uninstall from the menu in the upper left and click Uninstall.

6. Follow the on-screen instructions to uninstall the User’s Guide.



Paper Handling 21

Chapter 2 

Paper Handling

Using Special Paper

You can achieve good results with most types of plain bond paper. However, coated 
papers provide superior printouts because they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet printers, 
and recommends these papers to ensure high-quality results.

& See “Paper, Consumables, and Options” on page 187.

When loading special paper distributed by Epson, read the instruction sheets packed with 
the paper first and keep the following points in mind.

Note:
❏ Load the paper into the rear sheet feeder printable side up. The printable side is usually whiter 

or glossier. See the instruction sheets packed with the paper for more information.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing 
on curled paper may cause ink to smear on your printout.

Paper Loading Capacities 

Refer to the table below for the loading capacities of Epson special paper and other paper. 

Front paper cassette:

Media Type Loading Capacity

Epson Bright White Paper Up to 400 sheets 

Plain paper Up to 500 sheets
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Rear sheet feeder:

Note:
❏ If the paper is curled, flatten it or curl it slightly in the opposite direction. Make sure the paper 

stack fits under the c arrow mark inside the edge guide.

❏ Maximum capacity for plain paper depends on the weight and thickness of the paper.

❏ The output tray has a maximum capacity of 170 sheets.

You can purchase genuine Epson ink and paper at Epson Supplies CentralSM at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase 
supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON 
(800-463-7766).

Loading Paper

Follow these steps to load paper:

Media Type Loading Capacity

Plain paper (letter-size) Up to 150 sheets 

Plain paper (legal-size) 1 sheet at a time (up to 60 
sheets with the optional 
legal-size paper support)

Epson Bright White Paper Up to 100 (70 sheets for manual 
double-sided printing)

Epson Premium Presentation Paper Matte Up to 20 sheets

Epson Premium Presentation Paper Matte 
Double-Sided

1 sheet at a time

Epson Photo Quality Self Adhesive Sheets 1 sheet at a time

Epson Presentation Paper Matte Up to 100 sheets

Envelopes Up to 15 envelopes

www.epson.com/ink
www.epson.com/ink
www.epson.ca
www.epson.ca
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Front Paper Cassette

1. Pull out the front paper cassette.

2. Squeeze the edge guides and slide them out until they click into place.

3. Fan a stack of paper, then tap it on a flat surface to even the edges.

4. Load the paper with the printable side down.

MODIFY TO SHOW LETTER SIZE
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Note:
Avoid adding paper before running out of paper. Doing so may prevent the paper from feeding 
smoothly.

5. Squeeze the edge guides and slide them against the paper until they click.

6. Gently reinsert the cassette into the printer.

c
Caution:
To avoid paper jams, do not force the front paper cassette into the printer and check the 
edge guides after inserting the cassette.

7. Slide out and extend the extension tray.
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Note:
❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Make sure the paper stack fits under the c arrow mark inside the left edge guide.

Rear Sheet Feeder

1. Open the paper support.

2. Slide out and extend the extension tray.

3. Slide the edge guide to the left.

4. Fan a stack of paper, then tap it on a flat surface to even the edges.
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5. Load the paper with the printable side up, against the right side of the rear sheet feeder. 
Then slide the edge guide against the left edge of the paper.

Note:
❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Always load paper into the rear sheet feeder short edge first, even when you are printing 
landscape-oriented pictures.

❏ Avoid adding paper before running out of paper. Doing so may prevent the paper from feeding 
smoothly.

❏ Make sure the paper stack fits under the c arrow mark inside the left edge guide.

Using the Optional Legal-Size Paper Support

Align the legal-size paper support with the right side of the paper support and attach it as 
shown. You can load up to 60 sheets of plain legal-size paper (up to 20 lb or 75 g/m²).

Do not leave legal-size paper in the rear sheet feeder when you are not printing, or the 
sheets may curl.
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Loading Envelopes

Follow these steps to load envelopes:

1. Open the paper support.

2. Slide out and extend the extension tray.

3. Slide the left edge guide to the left.
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4. Load envelopes short edge first with the flap facing down and to the left. Then slide the 
left edge guide against the left edge of the envelopes.

Note:
❏ The thickness of envelopes and their ability to fold vary widely. If the total thickness of the stack 

of envelopes exceeds 0.6 inch (15 mm), press down on the envelopes to flatten them before 
loading. If print quality declines when a stack of envelopes is loaded, load one envelope at a 
time.

❏ You can load up to 15 envelopes at a time in the rear sheet feeder.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.

For printing instructions, see the following instructions.
& See “Printing on Envelopes” on page 46.
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Setting Up the Output Tray

The output tray is located on the front paper cassette. Slide out the extension tray and then 
open the flap on the extension tray to prevent your prints from slipping off the printer. The 
maximum capacity of the output tray is 170 sheets.

Selecting the Correct Paper Type or Media Type

The printer automatically adjusts itself for the type of paper you select in your print settings. 
That is why the paper type or media type setting is so important. It tells your printer what 
kind of paper you are using and adjusts the ink coverage accordingly. The table below lists 
the settings you should choose for your paper.

For this paper Select this paper type (media 
type) setting

Plain paper Plain Paper/Bright White Paper

Epson Bright White Paper

Epson Premium Presentation Paper Matte Premium Presentation Paper 
Matte

Epson Premium Presentation Paper Matte 
Double-Sided

Epson Presentation Paper Matte Presentation Paper Matte

Envelopes Envelope



Basic Printing 30

Chapter 3 

Basic Printing

Introduction

This section guides you through the procedures for different kinds of printing.

Printing Documents

Explains how to print documents on various types of paper.
& See “Printing Documents” on page 31.

Printing Photos

Explains how to print photos on various types of paper.
& See “Printing Photos” on page 37.
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Printing Web Pages

Explains how to print Web pages so that they fit on a sheet of paper without getting cut off 
on the right side.
& See “Printing Web Pages” on page 43.

Printing on Envelopes

Explains how to print on envelopes.
& See “Printing on Envelopes” on page 46.

Printing Documents
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Loading Paper

Refer to the section below for details on loading paper.

& See “Loading Paper” on page 22.

When using special Epson paper, refer to the section below.

& See “Using Special Paper” on page 21.

Printer Settings for Windows

1. Open the file you want to print.

2. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.
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3. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents with higher text quality

❏ Text & Image for higher quality documents with text and images

4. Select the paper source as the Source setting.

5. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

6. Select the appropriate Size setting. You can also define a custom paper size. For 
details, see the online help.

7. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

8. Click OK to close the printer settings window.

9. Print your file.

Note:
You can also print on both sides of the paper.

& See “Double-Sided (Duplex) Printing” on page 54.

Printer Settings for Mac OS X 10.5

Follow these steps to adjust your printer settings.

1. Open the file you want to print.

2. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.
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3. Click the d button to extend this dialog.

4. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.



Basic Printing 35

5. Select Print Settings from the pop-up menu.

6. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

7. Click Print to start printing.

Printer Settings for Mac OS X 10.3 or 10.4

1. Open the file you want to print.

2. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

3. Select the printer you are using as the Format for setting, and then make suitable 
settings.

4. Click OK to close the Page Setup dialog.

5. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

6. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.
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7. Select Print Settings from the pop-up menu.

8. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

9. Click Print to start printing.

Printing Photos

Preparing the Print File

You need to adjust the image file to the size of the paper. If your application has margin 
settings, make sure that the margins are within the printable area of the page. 
& See “Printable Area” on page 190.
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Loading Paper

Refer to the section below for details on loading paper.

& See “Loading Paper” on page 22.

When using special Epson paper, refer to the section below.

& See “Using Special Paper” on page 21.

Printer Settings for Windows

Follow these steps to adjust your printer settings.

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select Photo in the Quality Option settings.
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3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting. You can also define a custom paper size. For 
details, see the online help.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.5

Follow these steps to adjust your printer settings.

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.
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3. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Print Settings from the pop-up menu.

5. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.3 or 10.4

Follow these steps to adjust your printer settings.

1. Access the Page Setup dialog.



Basic Printing 42

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting, and then make suitable 
settings.

3. Click OK to close the Page Setup dialog.

4. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.
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6. Select Print Settings from the pop-up menu.

7. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printing Web Pages

Loading Paper

Refer to the section below for details on loading paper.

& See “Loading Paper” on page 22.

When using special Epson paper, refer to the section below.

& See “Using Special Paper” on page 21.
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Using EPSON Web-To-Page

The EPSON Web-To-Page software lets you print Web pages so that they fit within the 
width of your selected paper.

Note for Windows users:
This software is not available for Windows Vista and XP x64.

Note for Windows Internet Explorer 7 users:
Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7.

Note for Mac OS X users:
❏ This software is not available for Mac OS X.

❏ Printing web pages to fit to your paper size is available by using the printer driver.

& See “Printer Settings for Mac OS X 10.5” on page 33.
& See “Printer Settings for Mac OS X 10.3 or 10.4” on page 35.

1. In Internet Explorer, go to the Web page you want to print.

If you have installed EPSON Web-To-Page, the EPSON Web-To-Page toolbar appears 
on the Internet Explorer window.

2. Click the Print button on the toolbar. The Print window appears.

Note:
If you want to preview the layout of your printout, click the Preview button on the toolbar.
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3. Right-click the printer icon and choose Printing Preferences in Windows XP and 2000.

4. Click the Main tab, then select Web as the Quality Option settings:

5. Select the paper source as the Source setting.

6. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

7. Select the appropriate Size setting. You can also define a custom paper size. For 
details, see the online help.

8. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

9. Click OK to close the printer settings window.

10.Print your page.
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Printing on Envelopes

Loading Envelopes

Refer to the section below for loading envelopes.

& See “Loading Envelopes” on page 27.

Refer to the section below for the printable area.

& See “Printable Area” on page 190.

Printer Settings for Windows

1. Access the printer settings.
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& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Text for most envelopes

❏ Text & Image to print images on the envelope

3. Select Rear Tray as the Source setting.

4. Select Envelope as the Type setting.

5. Select the appropriate envelope size from the available Size settings. You can also 
define a custom size. For details, see the online help.

6. Select Landscape as the Orientation setting.

7. Click OK to close the printer settings window.

8. Print your envelope.
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Printer Settings for Mac OS X 10.5

Follow these steps to adjust your printer settings.

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then select a suitable 
envelope size as the Paper Size setting. You can also define a custom envelope size. 
For details, see the online help.

4. Select Landscape as the Orientation setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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5. Select Print Settings from the pop-up menu.

6. Select Envelope as the Media Type setting.

7. Make other settings that you want to use to print. See online help for details of Print 
Settings.

8. Click Print to start printing.
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Printer Settings for Mac OS X 10.3 or 10.4

1. Access the Page Setup dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting.

3. Select the appropriate envelope size as the Paper Size setting. You can also define a 
custom envelope size. For details, see the online help.

4. Select Landscape as the Orientation setting.

5. Click OK to close the Page Setup dialog.

6. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.
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7. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.

8. Select Print Settings from the pop-up menu.

9. Select Envelope as the Media Type setting.

10.Make other settings that you want to use to print. See online help for details of Print 
Settings.

11.Click Print to start printing.

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the Cancel Button on the Printer

For B-500DN users
Press the + Cancel button to cancel a print job in progress.

For B-300 users
Press the ) Paper/Cancel button to cancel a print job in progress.
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Canceling from Windows

When you start printing, the progress meter appears on your computer screen.

Click the Stop button to cancel printing.

Canceling from Mac OS X

Follow the steps below to cancel a print job.

1. Click your printer icon in the Dock.

2. In the Document Name list, select the document that is printing.
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3. Click the Delete button to cancel the print job.
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Chapter 4 

Printing with Special Layout Options

Introduction 

You can print with a variety of layouts for special projects, such as booklets and posters.

Double-Sided (Duplex) Printing

Lets you print on both sides of the paper.
& See “Double-sided (Duplex) Printing” on page 56.

Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size 
selected in the printer driver.
& See “Fit to Page Printing” on page 76.
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Note for Mac OS X users:
This feature is not available for Mac OS X 10.3.

Pages Per Sheet Printing

Lets you print two or four pages on a single sheet of paper.
& See “Pages Per Sheet Printing” on page 84.

Poster Printing (for Windows only)

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of 
paper, and then make a poster.
& See “Poster Printing (for Windows only)” on page 92.

Watermark Printing (for Windows only)

Lets you print text or an image as a watermark on each page of your printout.
& See “Watermark Printing (for Windows only)” on page 97.
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For example, you can put “Confidential” on an important document.

Double-sided (Duplex) Printing

Two types of double-sided printing are available: standard and folded booklet.

Standard double-sided printing lets you automatically print on both sides of the page (on 
plain paper only), using the duplex unit. 

Without the duplex unit, you can print the odd-numbered pages first. Once these pages are 
printed, you can reload them to print the even-numbered pages onto the opposite side of 
the paper.
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Folded booklet double-sided printing allows you to make single-fold booklets. The pages 
that will appear on the outside (after the page is folded) are printed first. The pages that will 
appear inside the booklet can then be printed after you reload the paper into the printer.

✽: Binding edge

You can create a booklet by printing pages 1 and 4 on the first sheet of paper, pages 5 and 
8 on the second sheet, and pages 9 and 12 on the third sheet.

After you reload these sheets into the rear sheet feeder, you can then print pages 2 and 3 
on the back of the first sheet of paper, pages 6 and 7 on the back of the second sheet, and 
pages 10 and 11 on the back of the third sheet.

The resulting pages can then be folded and bound together into a booklet.

Note:
❏ Depending on the paper, stacks of up to 30 sheets can be loaded into the rear sheet feeder 

during double-sided printing.

❏ Only use papers that are suitable for double-sided printing. Otherwise, the printout quality may 
deteriorate.

❏ Depending on the paper and the amount of ink used to print text and images, ink may bleed 
through to the other side of the paper.

❏ The surface of the paper may be smeared during double-sided printing.
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Standard Double-sided Printing for Windows

Automatic Double-sided Printing (Using the Duplex Unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet using the duplex unit.

Note:
The duplex unit is standard on the B-500DN and available as an option for the B-300. Automatic 
double-sided printing supports plain paper and Epson Bright White Paper only. Thick plain paper is 
not supported for automatic double-sided printing.

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages
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❏ Text & Image for higher quality pages with text and images

❏ Web for web pages

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select Plain Paper/Bright White Paper as the Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Select Duplex Printing. 

8. Click OK to save your settings.

9. Click OK or Print to start printing.

Note:
Do not try to pull out your prints before both sides of the page are printed.

Special Settings for Automatic Double-sided Printing (Using the Duplex 
Unit)

When you print photos or heavy text on both sides of the page, you can adjust the print 
density and drying time to prevent ink from bleeding through to the other side. You can also 
adjust the margins to allow for binding your pages.

Note:
Automatic double-sided printing supports plain paper and Epson Bright White Paper only.

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Select the appropriate Quality Option, Paper Options, and Orientation.

& See “Automatic Double-sided Printing (Using the Duplex Unit)” on page 58.
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3. Click the Page Layout tab, then select the Duplex Printing check box.

4. Select Auto to use the automatic double-sided printing function.

5. Click Adjust Print Density to open the Print Density Adjustment window.

6. Select the appropriate document type as the Select Document Type setting.

7. Specify the Print Density and Increased Ink Drying Time as the Adjustments setting.
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Note:
When you print dense photos on both sides of the paper, reduce the print density and increase 
the drying time to improve quality.

8. Click OK to return to the Page Layout window.

9. Click Margins to open the Margins window.

10.Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

11.Choose cm or inch as the Unit setting. Then specify the width of the binding margin. 
You can enter any width from 0.12 to 1.18 inches or 0.3 to 3.0 cm.

Note:
The actual binding margin may be different from the specified settings depending on your 
application. Experiment with a few sheets to examine actual results before printing the entire 
job.

12.Click OK to return to the Page Layout window. Then click OK to save your settings.

13.Load paper into the printer, then send the print job from your application.

& See “Loading Paper” on page 22.

Note:
Do not try to pull out your prints before both sides of the page are printed.

Manual Double-sided Printing

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet.

1. Access the printer settings.
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& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Web for web pages

❏ Photo for good quality and speed

3. Select Rear Tray as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select the Duplex Printing check box.

8. Select Manual to use manual double-sided printing function.

9. Click Margins to open the Margins window.
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10.Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

11.Choose cm or inch as the Unit setting. Then specify the width of the binding margin. 
You can enter any width from 0.12 to 1.18 inches, or from 0.3 to 3.0 cm.

Note:
The actual binding margin may be different from the specified settings depending on your 
application. Experiment with a few sheets to examine actual results before printing the entire 
job.

12.Click OK to return to the Page Layout window. Then click OK to save your settings.

13.Load paper into the rear sheet feeder, then send the print job from your application. 
Instructions for generating the even-numbered pages will be displayed while the 
odd-numbered pages are printed.

& See “Loading Paper” on page 22.

14.Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. Should this occur, slightly 

curl the sheets in the opposite direction before reloading them.

❏ Align the sheet stack by tapping its edges against a hard, flat surface before reloading the 
stack.

❏ Follow the on-screen instructions when reloading the printouts. Otherwise, paper may jam 
or the binding margins may be incorrect.

❏ If a paper jam occurs, refer to the following.
& See “The Paper Jams” on page 165.

15.Once the paper is reloaded, click Resume to print the even-numbered pages.

Standard Double-sided Printing for Mac OS X 10.5

Automatic Double-sided Printing (Using the Duplex Unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet using the duplex unit.

Note:
❏ Automatic double-sided printing supports plain paper only.

❏ Thick plain paper is not supported for automatic double-sided printing.
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1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the Printer and Option Information button.
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3. Make sure that Duplexer Installed is displayed in the Auto Duplex Printing Information 
section, and then click OK.

4. Close the EPSON Printer Utility3 dialog.

5. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

6. Click the d button to extend this dialog.
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7. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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8. Select Print Settings from the pop-up menu.

9. Select Plain Paper/Bright White Paper as the Media Type setting.

10.Make other settings that you want to use to print. See online help for details of Print 
Settings.
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11.Select Auto Duplex Printing Settings from the pop-up menu.

12.Select the Auto Duplex Printing check box.

13.Select the Binding edge setting.

14.Select one of the Document Type settings. This automatically adjusts Print Density and 
Ink Drying Time.

Note:
If you are printing high-density data, such as photos or graphs, we recommend adjusting the 
Print Density.

15.Load paper into the printer, and click Print.

& See “Loading Paper” on page 22.
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Standard Double-sided Printing for Mac OS X 10.3 or 10.4

Automatic Double-sided Printing (Using the Duplex Unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet using the duplex unit.

Note:
❏ Automatic double-sided printing supports plain paper only.

❏ Thick plain paper is not supported for automatic double-sided printing.

1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the Printer and Option Information button.

3. Make sure that Duplexer Installed is displayed in the Auto Duplex Printing Information 
section, and then click OK.

4. Close the EPSON Printer Utility3 dialog.

5. Access the Page Setup dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

6. Select the printer you are using as the Format for setting.

7. Select A4, Letter, or B5 as the Paper Size setting. 

8. Select the appropriate Orientation setting, and click OK to close the Page Setup dialog.
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9. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

10.Select Print Settings from the pop-up menu.

11.Select plain papers as the Media Type setting.

12.Make the settings that you want to use to print. See online help for details of Print 
Settings.
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13.Select Auto Duplex Printing Settings from the pop-up menu.

14.Select the Auto Duplex Printing check box.

15.Select the Binding edge setting.

16.Select one of the Document Type settings. This automatically adjusts Print Density and 
Ink Drying Time.

Note:
If you are printing high-density data, such as photos or graphs, we recommend adjusting the 
Print Density.

17.Load paper into the printer, and click Print.

& See “Loading Paper” on page 22.

Folded Booklet Double-sided Printing (for Windows only)

Manual double-sided printing

Use the following steps to create a folded booklet.

Note:
Folded booklet double-sided printing function is available only when manual double-sided printing 
is set.
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1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Web for web pages

❏ Photo for good quality and speed

3. Select Rear Tray as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.
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5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab and select the Duplex Printing check box. Then select 
Manual and select the Folded Booklet check box.

8. Click Margins to open the Margins window.
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9. Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

Note:
When you select Portrait as the Orientation setting, the Left or Right binding positions are 
available. The Top binding position is available when you select Landscape as the Orientation 
setting.

10.Choose cm or inch as the Unit setting. Specify the width of the binding margin.

* : Folding edge

** : Margin

You can enter any width from 0.12 to 1.18 inches, or from 0.3 to 3.0 cm. The specified 
margin width will be used on both sides of the fold. For example, if you specify a 1 inch 
margin, you will get a 2 inch margin (a margin of 1 inch will be placed on each side of 
the fold).

11.Click OK to return to the Page Layout window. Then click OK to save your settings.

12.Load paper into the rear sheet feeder, then send the print job from your application. 
Instructions for printing the inside pages will be displayed while the outside pages are 
printed.

& See “Loading Paper” on page 22.

13.Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. Should this occur, slightly 

curl the sheets in the opposite direction before reloading them.

❏ Align the sheet stack by tapping its edges against a hard, flat surface before reloading it in 
the printer.

Portrait Landscape
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❏ Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or 
the binding margins may be incorrect.

❏ If a paper jam occurs, refer to the following.
& See “The Paper Jams” on page 165.

14.Once the paper is reloaded, click Resume to print the inside pages.

15.Once printing is complete, fold the sheets and bind them together using a stapler or 
other binding method.

Fit to Page Printing

You can use the Fit to Page printing function when you want to print, for example, a letter 
size document on another size paper.

Fit to Page printing automatically resizes your page to the paper size you select. You can 
also resize your page manually.
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Printer Settings for Windows

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Web for web pages

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.
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& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select the Reduce/Enlarge Document check box.

8. Do one of the following:

❏ If you selected By Output Paper Size, select the size of the paper you are using 
from the drop-down list.

❏ If you selected By Percentage, use the arrows to choose a percentage.

9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.
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Printer Settings for Mac OS X 10.5

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Paper Handling from the pop-up menu.

5. Select the Scale to fit paper size.

6. Make sure that the appropriate size is displayed in Destination Paper Size.
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7. Select Print Settings from the pop-up menu.

8. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.
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Printer Settings for Mac OS X 10.4

1. Access the Page Setup dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting and then make suitable 
settings.

3. Click OK to close the Page Setup dialog.

4. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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6. Select Paper Handling from the pop-up menu.

7. Select Scale to fit paper size as the Destination Paper Size.

8. Select the appropriate paper size from the pop-up menu.

9. Select Print Settings from the pop-up menu.

10.Make the settings that you want to use to print. See online help for details of Print 
Settings.
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& See “Selecting the Correct Paper Type or Media Type” on page 29.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Pages Per Sheet Printing

Pages Per Sheet printing allows you to print two or four pages on single sheets of paper.

Printer Settings for Windows

1. Access the printer settings.
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& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Web for web pages

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, select Multi-Page, then select Pages Per Sheet.

8. Select from the following settings for Pages Per Sheet printing:

9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

2, 4 Prints two or four pages of your document on a single piece of 
paper.

Print Page 
Borders

Prints frames around the pages printed on each sheet.

Page Order Allows you to specify the order in which the pages will be printed on 
the sheet of paper. Some settings may be unavailable, depending 
on the Orientation setting on the Main window.
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Printer Settings for Mac OS X 10.5

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Layout from the pop-up menu.

5. Select from the following settings:

Pages per 
Sheet

Prints multiple pages of your document on a single piece of paper.

You can choose from 1, 2, 4, 6, 9, or 16. 

Layout 
Direction

Allows you to specify the order in which the pages will be printed on 
the sheet of paper. 

Border Prints a border around the pages printed on each sheet. You can 
choose from None, Single Hairline, Single Thin Line, Double Hairline, 
or Double Thin Line.
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6. Select Print Settings from the pop-up menu.

7. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.3 or 10.4

1. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting, and then make suitable 
settings.

3. Click OK to close the Page Setup dialog.

4. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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6. Select Layout from the pop-up menu.

7. Select from the following settings:

Pages per 
Sheet

Prints multiple pages of your document on a single piece of paper. 
You can choose from 1, 2, 4, 6, 9, or 16.

Layout 
Direction

Allows you to specify the order in which the pages will be printed on 
the sheet of paper.

Border Prints a border around the pages printed on each sheet. You can 
choose from None, Single Hairline, Single Thin Line, Double Hairline, 
or Double Thin Line.
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8. Select Print Settings from the pop-up menu.

9. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Poster Printing (for Windows only)

Poster printing allows you to print poster-size images by enlarging one page to cover 
several sheets of paper.
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Printer Settings

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents

❏ Text & Image for higher quality pages with text and images

❏ Web for web pages

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.
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& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab and select Multi-Page, then select Poster Printing. Click 
the up or down arrow to select 2x1, 2x2, 3x3, or 4x4.
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8. Click Settings to adjust the way your poster will be printed. The Poster Settings window 
opens.

9. Make the following settings:

Note:
If you want to print only a few of the panels without printing the entire poster, click the panels 
that you do not want to print.

10.Click OK to close the Poster Settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job. Then follow the instructions.
& See “How to Make a Poster from Your Printouts” on page 96.

Print Cutting 
Guides

Prints guide lines for cutting.

Overlapping 
Alignment 
Marks

Slightly overlaps the panels and prints alignment markers so that the 
panels can be aligned more precisely.

Trim Lines Prints border lines on the panels to guide you when trimming the 
pages.
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How to Make a Poster from Your Printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and 
Overlapping Alignment Marks selected as the Print Cutting Guides.

1. Cut off the margin of Sheet 1 along a vertical line through the center of the top and 
bottom cross marks: 

2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily 
tape the two sheets together from the back:

3. Cut the taped sheets in two along a vertical line through the alignment markers (this 
time, a line to the left of the cross marks):
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4. Align the edges of the paper using the alignment markers and tape them together from 
the back:

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top and bottom edges of the 
paper:

7. Cut off the remaining margins.

Watermark Printing (for Windows only)

Watermark printing allows you to print a text-based or image-based watermark on your 
document.
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Printing the Watermark

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents with higher text quality

❏ Text & Image for higher quality documents with text and images

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 29.

5. Select the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, choose the desired watermark from the Watermark list, then 
click Settings.

If you want to create your own watermark, see the following instructions.
& See “Creating Your Own Watermark” on page 100.
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8. Specify the settings you want for the watermark. You can change the position and size 
of the watermark by dragging the image within the preview window.

9. Click OK to return to the Page Layout window.

10.Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Creating Your Own Watermark

You can add your own text-based or image-based watermarks to the Watermark list.
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1. Click Add/Del under Watermark on the Page Layout window. The following window 
appears.

2. Do one of the following:

❏ To use an image file as a watermark, select BMP. Click Browse to locate the bitmap 
file you want to use, then click Open. Type a name for your watermark in the Name 
text box, then click Save.

❏ To create a text-based watermark, select Text. Type your text in the Text box. This 
text will also be used as the watermark name. If you want to change the watermark 
name, type a new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout window.
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4. Click Settings. The following window appears: 

5. Make sure that the appropriate watermark is selected in the Watermark list, then select 
Color, Position, Density, Size, Font, Style, and Angle settings. (For details, see the 
online help.) Your settings are reflected in the preview window.

6. When you finish making settings, click OK.
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Chapter 5 

Using the Control Panel

Introduction

You can use the printer’s control panel to access a variety of menus that allow you to check 
the status of consumable products, print status sheets, and make printer settings. This 
section describes how to use the control panel.

For B-500DN Users

Explains how to use the control panel for B-500DN.

❏ “Buttons and Lights” on page 104

❏ “Icons on the LCD” on page 106

❏ “How to Access the Control Panel Menus” on page 107

❏ “Control Panel Menu List” on page 107

❏ “Status and Error Messages” on page 110

❏ “Printing the Status Sheet” on page 112

For B-300 Users

Explains how to use the control panel for B-300.

❏ “Buttons and Lights” on page 113

❏ “Status and Error Lights” on page 114

❏ “Printing the Status Sheet” on page 118
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For B-500DN Users

The control panel of the printer consists of 7 buttons, 3 lights, and a liquid crystal display 
(LCD).

Buttons and Lights

The table below describes the functions of the buttons on the control panel.

Button Description

Power button

Turns the printer on or off.

Cancel button

Cancels the print job if pressed during printing.

Returns to the Ready status when pressed in Menu mode.

Left button

Returns to the previous level when pressed in Menu mode.
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The table below describes the meanings of the lights on the control panel. The lights let you 
know the status of the printer and the type of an error when it occurs.

Up button

Changes the parameter in the reverse order when selecting a desired 
parameter in Menu mode.

Down button

Changes the parameters in forward order when selecting a desired 
parameter in Menu mode.

Right button

Enters Menu mode when pressed in the Ready status.

Selects a desired menu when pressed in Menu mode.

OK button

Sets the selected parameter in the selected item in Menu mode.

Executes the item if the selected item is for execution only.

Feeds the paper when paper feed failed.

Light Description

Ink status light 
(orange)

On:
The installed ink cartridge is expended.
The ink cartridge is not installed.
The installed ink cartridges cannot be used with the printer.
The cartridge lock lever is in the unlocked position.
The installed maintenance box is at the end of its service life. 
The maintenance box is not installed.
The installed maintenance box cannot be used with the printer.
The maintenance box cover is open.

Flashing:
The installed ink cartridge is nearly expended.
The maintenance box is nearing the end of its service life.

Paper status light 
(orange)

On:
No paper is loaded in the paper source.
The printer loads more than one sheet of paper at a time.

Flashing:
Paper is jammed.
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Icons on the LCD

This section describes the meaning of icons displayed on the LCD screen.

The table below describes the meaning of ink cartridge status icon.

The table below describes the meaning of maintenance box status icon.

Power light (green)

On:
The printer is in the Ready status.

Flashing:
The printer is starting.
The printer is printing.
The printer is cleaning the print head.
The printer is charging the ink.
The printer is canceling printing.

Off:
The printer is off.

Icon Description

The icon gives a rough estimate of the useable ink remaining in 
the ink cartridge.

The installed ink cartridge is nearly expended.

The installed ink cartridge is expended.

The ink cartridge is not installed.

The installed ink cartridges cannot be used with the printer.

Icon Description

The icon gives a rough estimate of the remaining capacity of 
the maintenance box.

The installed maintenance box is nearing the end of its service 
life.
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How to Access the Control Panel Menus

This section describes how to enter Menu mode and make settings with the buttons on the 
control panel.

Note:
❏ Press the + Cancel button whenever you want to exit Menu mode and return to the Ready 

status.

❏ Press the l Left button to return to the previous step.

1. Make sure that READY appears on the LCD screen, and then press the r Right button. 
The first menu appears on the LCD screen.

2. Press the d Down or u Up button to scroll through the menus. 

3. Press the OK or r Right button to select the desired menu. The first item appears on 
the LCD screen.

4. Press the d Down or u Up button to scroll through the items.

5. Press the OK or r Right button to select the desired item. The first parameter appears 
on the LCD screen.

6. Press the d Down or u Up button to scroll through the parameters.

7. Press the OK button to store the selected parameter. If the parameter is for execution 
only, press the OK button to execute the function for the item.

After execution, the printer returns to the previous menu.

8. Press the + Cancel button. The printer returns to the Ready status.

Control Panel Menu List

This section describes the parameter for each item in the menu.

The installed maintenance box is at the end of its service life.

The maintenance box is not installed.

The installed maintenance box cannot be used with the printer.
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Printer Setting Menu

This menu allows you to configure the basic printer setting.

Language

You can select the language displayed on the LCD screen from the following list: English, 
French, Italian, German, Spanish, Portuguese, Dutch, Japanese.

Test Print Menu

This menu allows you to make settings related to test print.

Nozzle check

You can print a print head nozzle check pattern for each ink cartridge. From the printing 
results, you can check whether the nozzles are delivering ink properly. 

& See “Checking the Print Head Nozzles” on page 137.

Status sheet

You can print the current printer status. 

& See “Printing the Status Sheet” on page 112.

Network sheet

You can print the current settings of the network interface.

Printer Status Menu

This menu allows you to check the current printer status.

Version

You can check the firmware version.

Maintenance box

You can get a rough estimate of the remaining capacity of the maintenance box. 

Maintenance Menu

This menu allows you to make settings related to maintenance.
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Head alignment

You can print a head alignment test pattern. From the printing results, you can adjust the 
head alignment.

Cleaning

You can clean the print head. You can also print a nozzle check pattern before cleaning.

Cleaning sheet

You can clean up the rollers inside the printer.

Contrast adj.

You can adjust the contrast of the LCD screen. Press the u Up or d Down button to adjust 
contrast.

Network Setting Menu

This menu allows you to make network settings.

Network setup

You can select the method to configure the network settings.

When Auto is selected, the printer obtains the IP address, Subnet mask and Default 
gateway automatically. When Panel is selected, you can specify the IP address, Subnet 
mask, and Default gateway settings using the control panel. When Init N/W set is selected, 
you can revert the network settings of the printer to the factory default value.

IP address, Subnet mask, Default gateway

You can set the IP address, Subnet Mask, and Default Gateway to the printer. To change 
the parameter, press the l Left or r Right button to move cursor and the u Up or d Down 
button to change number.

Item Parameter

Network setup Auto -

Panel IP address 000.000.000.000–255.255.255.255

Subnet mask 000.000.000.000–255.255.255.255

Default gateway 000.000.000.000–255.255.255.255

Init N/W set -
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Status and Error Messages

This section describes the meaning of messages displayed on the LCD screen.

The table below describes the status messages.

The table below contains error messages, a brief description of each message and 
suggestions for correcting the problem.

Message Description

Cancel The print job is canceled.

Charging ink The printer is charging the ink.

Cleaning The printer is cleaning the print head.

Please wait The printer is starting.

The printer is initializing the settings.

Printing The printer is processing data.

Ready The printer is ready to print.

Power save The printer is in the power save mode.

Power off The printer is shutting down.

Message Problem Solutions

Service call see guide Service call error occurs. Turn off the printer and then back 
on. If the error does not clear, 
contact Epson.

& See “Where To Get Help” on 
page 182.

Printer near end of 
service life

Parts inside the printer are at the 
end of their service life.

Contact Epson to replace the 
parts.

& See “Where To Get Help” on 
page 182.

Nozzle maint error see 
guide

Print head nozzles are clogged or 
misaligned.

Perform a nozzle check and print 
head cleaning.

& See “Checking the Print Head 
Nozzles” on page 137.

& See “Cleaning the Print Head” 
on page 139.

Press the OK button to recover 
from error status.
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Printer error restart 
printer

Printer error occurs. Turn off the printer and make sure 
paper is not jammed. 

& See “The Paper Jams” on page 
165.

If the error still does not clear, 
contact Epson.

& See “Where To Get Help” on 
page 182.

Close maint box 
cover

The maintenance box cover is 
open.

Close the maintenance box 
cover.

Set maint box The maintenance box is not 
installed.

Install the maintenance box.

The maintenance box cannot be 
used with the printer.

Install a genuine maintenance 
box.

Replace maint box The maintenance box is full. Replace the maintenance box.

& See “Replacing the 
Maintenance Box” on page 135.

Move ink lever down The cartridge lever is in the 
unlocked position.

Move the cartridge lever to the 
locked position.

Set ink cartridge The ink cartridge is not installed. Install the ink cartridge.

Replace ink cartridge The ink cartridge cannot be used 
with the printer.

Install a genuine ink cartridge.

The ink cartridge is expended. Replace the ink cartridge.

& See “Replacing an Ink 
Cartridge” on page 128.

Set paper in cassette Paper is not loaded in the front 
paper cassette.

Load the paper in the front paper 
cassette.

Set paper in auto 
feeder

Paper is not loaded in the rear 
sheet feeder.

Load the paper in the rear sheet 
feeder.

Remove jammed 
paper

Paper is jammed in front paper 
cassette or rear sheet feeder.

Remove the jammed paper.

& See “The Paper Jams” on page 
165.

Double feed jam 
remove paper

The printer feeds more than one 
sheet of paper at a time.

Remove the jammed paper, and 
then press the OK button.

Close printer cover The printer cover is open during 
printing.

Close the printer cover.

Set duplex unit The duplex unit is removed. Attach the duplex unit.

Duplex unit jam 
remove paper

Paper is jammed in duplex unit. Remove the jammed paper.

& See “The Paper Jams” on page 
165.
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Printing the Status Sheet

While in Menu mode, you can print a status sheet to see the current default values. To print 
a status sheet, follow the steps below.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Press the r Right button to enter Menu mode.

3. Press the d Down or u Up button to display TEST PRINT, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to display STATUS SHEET, and then press the OK or 
r Right button.

5. Press the OK button to start printing a status sheet.

After printing is finished, the printer returns to the Test print menu.

For B-300 Users

The control panel of the printer consists of 3 buttons and 7 lights.
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Buttons and Lights

The table below describes the functions of the buttons on the control panel.

The table below describes the functions of the lights on the control panel. The lights let you 
know the status of the printer and the type of an error when it occurs.

Button Description

Power button

Turns the printer on or off.

Ink button

Cleans the print head if pressed and held for 3 seconds.

Prints a status sheet if the P Power button is pressed while holding down 
the H Ink button.

Paper/Cancel button

Feeds and ejects the paper.

Restart printing when a double feed error is detected.

Feeds the paper when paper feed failed.

Ejects the paper when the paper is jammed.

Cancels the print job if pressed during printing.

Prints the firmware version and the nozzle check pattern for each ink 
cartridge if the P Power button is pressed while holding down the 
) Paper/Cancel button.
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* Maintenance box status light is also on for these errors.

** Maintenance box status light also flashes for this error.

Status and Error Lights

This section describes the meaning of lights on the control panel.

The table below describes the lights showing the printer status.

= on, = flashing

Light Description

Ink status light 
(orange)

On:
The installed ink cartridge is expended.*

The ink cartridge is not installed.*

The installed ink cartridges cannot be used with the printer.*

Flashing:
The installed ink cartridge is nearly expended.**

Maintenance box 
status light (orange)

On:
The installed maintenance box is at the end of its service life.
The maintenance box is not installed.
The installed maintenance box cannot be used with the printer.
The maintenance box cover is open.
The cartridge lever is in the unlocked position.

Flashing:
The maintenance box is nearing the end of its service life.

Paper status light 
(orange)

On:
No paper is loaded in the paper source.
The printer loads more than one sheet of paper at a time.

Flashing:
Paper is jammed.
The duplex unit is not installed.

Power light (green)

On:
The printer is in the Ready status.

Flashing:
The printer is starting.
The printer is printing.
The printer is cleaning the print head.
The printer is charging the ink.
The printer is canceling printing.

Off:
The printer is off.
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The table below contains the lights showing the errors, a brief description and suggestions 
for correcting the problem.

= on, = flashing

Light Description

The printer is ready to print.

The printer is starting.

The printer is printing.

The printer is cleaning the print head.

The printer is charging the ink.

The print job is canceled.

Lights Problem and solution

Ink end

The installed ink cartridge is 
expended.

Replace the ink cartridge.

Ink cartridge error

The ink cartridge is not installed. Install an ink cartridge.

The ink cartridge is not detected. Install the ink cartridge again.

The installed ink cartridge cannot be 
used with the printer.

Install a genuine ink cartridge.

Ink low

The ink cartridge is nearly expended. Obtain a new ink cartridge.
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Maintenance box at the end of its service life

The maintenance box is at the end of 
its service life.

Replace the maintenance box.

Maintenance box error

The maintenance box is not installed. Install the maintenance box.

The maintenance box is not 
detected.

Install the maintenance box again.

The maintenance box cannot be 
used with the printer.

Install a genuine maintenance box.

The maintenance box cover is open. Close the maintenance box cover.

Cartridge lever unlocked

The cartridge lever is in the unlocked 
position.

Move the cartridge lever to the 
locked position.

Maintenance box nearing the end of its service life

The maintenance box is nearing the 
end of its service life.

Obtain a new maintenance box.

Paper out

Paper is not loaded. Load the paper, and then press the 
) Paper/Cancel button.

Double feed error

The printer feeds more than one 
sheet of paper at a time.

Remove the jammed paper, and 
then press the ) Paper/Cancel 
button.

Paper jam

The paper is jammed. Remove the jammed paper.

& See “The Paper Jams” on page 
165.

Paper size error

The paper size set in the printer driver 
and the size of loaded paper differ.

Match the paper size setting.

Duplex unit error

The duplex unit is not installed. Install the duplex unit.
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Printer cover open

The printer cover is open during 
printing.

Close the printer cover.

Printer error, restart printer

A printer error has occurred Turn off the printer and make sure 
paper is not jammed. 

& See “The Paper Jams” on page 
165.

If the error still does not clear, 
contact Epson.

& See “Where To Get Help” on page 
182.

Service required
(Lights flash alternately)

Parts inside the printer are at the end 
of their service life.

Contact Epson to replace them.

& See “Where To Get Help” on page 
182.

Nozzle maintenance required

Print head nozzles are clogged or 
misaligned.

Perform the nozzle check and print 
head cleaning.

& See “Checking the Print Head 
Nozzles” on page 137.

& See “Cleaning the Print Head” on 
page 139.

Press the H Ink button to recover from 
error status.

All lights

Unknown printer error

An unknown printer error has 
occurred.

Turn the printer off and then back on. 
If the error does not clear, contact 
Epson.

& See “Where To Get Help” on page 
182.
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Printing the Status Sheet

You can print a status sheet to see the current default values. To print a status sheet, follow 
the steps below.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Turn off the printer.

3. Turn on the printer while holding down the H Ink button.

The printer prints the status sheet.
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Chapter 6 

Installing Options

Optional Legal-size Paper Support

Installing the Optional Legal-size Paper Support

Align the legal-size paper support with the right side of the paper support and attach it as 
shown. You can load up to 60 sheets of plain legal-size paper (up to 20 lb or 75 g/m²). 

Do not leave legal-size paper in the rear sheet feeder when you are not printing, or the 
sheets may curl. 

Optional Duplex Unit (B-300 only)

Installing the Optional Duplex Unit

Follow the steps below to install the duplex unit.

1. Turn off the printer.

2. Press the hooks on both sides of the upper rear printer cover, and then remove the 
upper rear printer cover.
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Note:
The removed upper rear printer cover should be retained since it will be necessary if you 
remove the duplex unit.

3. Insert the bottom side of the duplex unit first, and then attach the duplex unit.

Uninstalling the Optional Duplex Unit

Follow the steps below to uninstall the duplex unit.

1. Turn off the printer.
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2. Remove the duplex unit by pulling it while holding down the buttons on both sides of the 
duplex unit.

3. Attach the upper rear printer cover.
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Chapter 7 

Replacing Consumables

Ink Cartridges

Checking the Ink Cartridge Status

Using the Control Panel (B-500DN)

To check the ink cartridge status, see “Icons on the LCD” on page 106.

Using the Printer Lights (B-300)

To check the ink cartridge status, see the B Ink status light for each color. The B Ink status 
lights let you know the status of the ink cartridge.

Using the Printer Utility for Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges 
are installed, the ink cartridge status will not be displayed.

To check the ink cartridge status, do one of the following:

❏ Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon 
to the taskbar, refer to the following section.
& See “From the Shortcut Icon on the Taskbar” on page 15.

Ink status light Status

Off The ink cartridge has enough ink for printing.

Flashing The ink cartridge is nearly expended.

On The ink cartridge is expended.
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❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status 
Monitor 3 button.

A graphic displays the ink cartridge status.

Note:
If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the 
ink cartridge status. Be sure to replace or reinstall any ink cartridges indicated by EPSON 
Status Monitor 3.

❏ The progress meter appears automatically when you start a print job. Click the Check 
Ink Levels button, and then you can check the ink cartridge status from this window.
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Note:
To display the progress meter automatically, click the Maintenance tab in the printer driver 
window, click Speed & Progress, and then select the Show Progress Meter check box.
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Using the Printer Utility for Mac OS X

Note for Mac OS X 10.5:
When an ink cartridge is running low, the Low Ink Reminder window automatically appears. You 
can also check the ink cartridge status from this window. If you do not want to display this window, 
select the Preferences menu from the Application menu when the Low Ink Reminder window is 
displayed, and then clear the Enable Low Ink Reminder check box.

You can check the ink cartridge status using EPSON StatusMonitor. Follow the steps 
below.

1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

Note:
❏ The graphic displays the ink cartridge status when EPSON StatusMonitor was first opened. To 

update the ink cartridge status, click Update.

❏ Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink 
cartridges are installed, the ink cartridge status may not be displayed.
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❏ If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON StatusMonitor will not display an accurate status of the ink 
cartridge. Be sure to replace or reinstall any ink cartridge indicated by the EPSON 
StatusMonitor.

Note for Mac OS X 10.5:
The printer monitor window appears automatically when you start a print job. You can check the ink 
cartridge status from this window.

Purchasing Epson Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

Purchase genuine Epson Cartridges and use them within six months of installing them and 
before the expiration date on the cartridge box. When you purchase new ink, use the 
following Epson ink cartridge numbers:

Note:
❏ We recommend that you use genuine Epson cartridges and do not refill them. The use of other 

products may affect your print quality and could result in printer damage.

❏ The printer ships with full cartridges and part of the ink from this first set of cartridges is used for 
charging the printer.

❏ Yields vary considerably based on images printed, print settings, paper type, frequency of use 
and temperature. For print quality, a small amount of ink remains in the cartridge after the 
"replace cartridge" indicator comes on.

❏ Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold temperatures, 
allow them to warm up to room temperature for at least 3 hours before using them.

Handling Precautions

Read all of the instructions in this section before replacing the ink cartridges.

Ink color Standard 
capacity

High Capacity (B-500DN 
only)

Extra High Capacity (B-500DN 
only)

Black T6161 T6171 T6181

Cyan T6162 T6172 —

Magenta T6163 T6173 —

Yellow T6164 T6174 —

www.epson.com/ink
www.epson.com/ink
www.epson.ca
www.epson.ca
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❏ This printer uses ink cartridges equipped with an IC chip that monitors the amount of ink 
used by each cartridge. Cartridges are usable even if they are removed and reinserted.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply 
area from dirt and dust. Store the ink cartridge in the same environment as the printer. 
When storing the cartridge, be sure that its label identifying the color of the ink cartridge 
is facing upward. Do not store ink cartridges upside down.

❏ The valve in the ink supply port is designed to contain any excess ink that may be 
released. However, careful handling is recommended. Do not touch the supply port of 
the ink cartridge or its surrounding area.

❏ Ink is consumed during the following operations: print head cleaning, initial ink 
charging, and nozzle maintaining.

❏ Never turn off the printer during initial ink charging. The ink may fail to be filled up and 
the printer may become unavailable to print.

❏ If you change the ink cartridge to Extra High Capacity Ink Cartridge, retain the default 
ink cartridge or Standard Capacity Ink Cartridge, or High Capacity Ink Cartridge. One of 
these cartridges is needed when you transport the printer.

❏ The use of other products not manufactured by Epson may affect your print quality and 
could result in printer damage that is not covered by Epson’s warranties.

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink the ink or 
handle the cartridges.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the 
ink supply port or surrounding area. If ink gets on your skin, wash the area thoroughly 
with soap and water. If ink gets into your eyes, flush them immediately with water. If 
discomfort or vision problems continue after a thorough flushing, see a doctor 
immediately.

❏ We recommend that you use genuine Epson cartridges and do not refill them. The use 
of other products may affect your print quality and could result in printer damage. Epson 
cannot guarantee the quality or reliability of non-genuine ink. The ink cartridge status is 
not displayed when non-genuine ink is used.

❏ Leave the old cartridge installed in the printer until you have obtained a replacement; 
otherwise, ink remaining in the print head nozzles may dry out.

❏ You cannot continue printing with one ink cartridge expended, even if the other 
cartridges still contain ink. Before printing, replace the expended cartridge.

❏ Never turn off the printer while replacing the ink cartridge. Doing so may damage the IC 
chip on the ink cartridge and the printer may not print properly.
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Replacing an Ink Cartridge

To replace the ink cartridge, follow the steps below.

1. Open the cartridge cover.

2. Move the cartridge lever to the unlocked position.

3. Remove the expended ink cartridge.

Note:
Hold the printer with your hand when you remove the ink cartridge.
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4. Remove the new ink cartridge from the package.

c
Caution:
❏ Do not touch the green IC chip on the side of the cartridge. This can damage the ink 

cartridge.

❏ Always install an ink cartridge immediately after removing the old cartridge. If the 
cartridge is not installed promptly, the print head may dry out and be unable to print.

5. For best results, shake the ink cartridge for about five seconds.
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6. Hold the ink cartridge with the arrow mark facing up and pointing to the rear of the 
printer, and then insert it into the slot.

Note:
Hold the printer with your hand when you install the ink cartridge.

c
Caution:
Do not remove and reinsert cartridges more often than necessary. Doing so can 
compromise the needle valve seal and allow air to enter the ink tubes, causing nozzle 
loss.

7. Move the cartridge lever to the locked position.
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8. Close the cartridge cover.

Note:
When you install the Extra High Capacity Ink Cartridge, use the printer with the cartridge cover 
opened.

Maintenance Box

Checking the Maintenance Box Status

Using the Control Panel (B-500DN)

To check the maintenance box status using the control panel, follow the steps below.

1. Make sure that READY appears on the LCD screen, and then press the r Right button. 
MENU appears on the LCD screen.

2. Press the d Down or u Up button to select PRINTER STATUS, and then press the OK or 
r Right button.

3. Press the d Down or u Up button to select MAINTENANCE BOX, and then press the OK 
or r Right button.

4. A rough estimate of the maintenance box capacity appears on the LCD screen.

Note:
You can check the maintenance box status by the icon displayed on the lower right of the LCD 
screen as well. 
& See “Icons on the LCD” on page 106.
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Using the Printer Lights (B-300)

To check the maintenance box status, see the Maintenance box status light. The 
Maintenance box status lights let you know the remaining free capacity of the 

maintenance box.

For Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine maintenance boxes. If a 
non-genuine maintenance box is installed, the maintenance box status will not be displayed.

To check the maintenance box status, do one of the following:

❏ Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon 
to the taskbar, refer to the following section.
& See “From the Shortcut Icon on the Taskbar” on page 15.

❏ Open the printer driver, click the Maintenance tab, then click the Status Monitor 3 
button.

Maintenance box status 
light

Status

Off The maintenance box has enough free capacity.

Flashing The maintenance box is nearing the end of its service life.

On The maintenance box is at the end of its service life.
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A graphic displays the maintenance box status.

Note:
❏ The printer ships with a new maintenance box, even though the service life indicator does 

not show 100% when the printer is new. EPSON Status Monitor 3 and the printer’s control 
panel will indicate when the maintenance box needs to be replaced.

❏ If the maintenance box installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of 
the maintenance box status. Be sure to replace or reinstall any ink cartridge indicated by 
EPSON Status Monitor 3.

For Mac OS X

You can check the maintenance box status using EPSON StatusMonitor. Follow the steps 
below.

1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.
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2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

Note:
❏ The graphic displays the maintenance box status when EPSON StatusMonitor was first 

opened. To update the maintenance box status, click Update.

❏ Epson cannot guarantee the quality or reliability of non-genuine maintenance boxes. If 
non-genuine maintenance boxes are installed, the maintenance box status may not be 
displayed.

❏ If the maintenance box installed in the printer is broken, incompatible with the printer model, or 
improperly installed, EPSON StatusMonitor will not display an accurate status of the 
maintenance box. Be sure to replace or reinstall the maintenance box.

Purchasing a Replacement Maintenance Box

You can purchase a genuine Epson maintenance box at Epson Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

www.epson.com/ink
www.epson.com/ink
www.epson.ca
www.epson.ca
www.epson.ca
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Handling Precautions

Read all of the instructions in this section before replacing the maintenance box.

❏ Epson recommends the use of genuine Epson maintenance boxes. The use of a 
non-genuine maintenance box may cause damage that is not covered by Epson’s 
warranties, and under certain circumstances, may cause erratic printer behavior. 
Epson cannot guarantee the quality or reliability of non-genuine maintenance boxes. 
The maintenance box status is not displayed when a non-genuine maintenance box is 
used.

❏ Do not dismantle the maintenance box.

❏ Do not touch the green IC chip on the side of the maintenance box.

❏ Keep out of reach of children, and do not drink the ink.

❏ Do not peel off the film covering the maintenance box.

❏ Do not tilt the used maintenance box until it is placed in the plastic bag provided.

❏ Do not reuse a maintenance box which has been removed and left detached for a long 
period.

Replacing the Maintenance Box

To replace the maintenance box, follow the steps below.

1. Confirm that the printer is ready and not printing.

2. Open the maintenance box cover.

3. Remove the new maintenance box from the package.

4. Lift up and pull the installed maintenance box outward.
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Note:
❏ Do not tilt the maintenance box when you remove it.

❏ Hold the maintenance box with both hands when you handle it.

5. Put the used maintenance box into the plastic bag, and then seal the bag.

Note:
The plastic bag is provided with the new maintenance box.

6. Insert the new maintenance box into place as far as it will go.

7. Close the maintenance box cover.
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Maintaining Your Printer

Checking the Print Head Nozzles

If you find that your printouts are unexpectedly faint or have gaps in them, you may be able 
to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility 
or from the printer by using the control panel or buttons.

Note:
The printer checks the print head on a regular basis to keep it clean and make sure you receive 
premium print quality. If print head nozzles are clogged, the printer automatically cleans the print 
head. Normally, you do not need to perform nozzle checks and print head cleaning; however, the 
self-cleaning function cannot completely prevent nozzle clogs.

Using the Nozzle Check Utility for Windows

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no lights are indicating errors.

2. Make sure that letter/A4 size paper is loaded in the front paper cassette.

3. Right-click the printer icon on the taskbar, then select Nozzle Check.

If the printer icon does not appear, refer to the following section to add the icon.

& See “From the Shortcut Icon on the Taskbar” on page 15.

4. Follow the on-screen instructions.

Using the Nozzle Check Utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no lights are indicating errors.

2. Make sure that letter/A4 size paper is loaded in the sheet feeder.
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3. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

4. Click the Nozzle Check button in the Utility dialog.

5. Follow the on-screen instructions.

Using the Control Panel (B-500DN)

Follow the steps below to check the print head nozzles using the control panel.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
Menu appears on the LCD screen.

3. Press the d Down or u Up button to select TEST PRINT, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select NOZZLE CHECK, and then press the OK or 
r Right button.

5. Press the OK button to print the nozzle check pattern.

After printing, the cleaning menu appears. If you find a print quality problem, press the 
OK button to clean the print head.

Using the Printer Buttons (B-300)

Follow the steps below to check the print head nozzles using the printer buttons.

1. Make sure that no lights are indicating errors.

2. Turn off the printer.

3. Make sure that letter/A4 size paper is loaded in the front paper cassette.
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4. Hold down the ) Paper/Cancel button and press the P Power button to turn on the 
printer.

5. When the printer turns on, release both the buttons.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there 
are no print quality problems, such as gaps or missing segments in the test lines, the 
print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a 
clogged ink nozzle or a misaligned print head.

& See “Cleaning the Print Head” on page 139.
& See “Aligning the Print Head” on page 143.

Cleaning the Print Head

If you find that your printouts are unexpectedly faint or have gaps in them, you may be able 
to solve these problems by cleaning the print head, which ensures that the nozzles are 
delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the 
printer driver or from the printer by using the control panel or buttons.
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Note:
❏ Clean the print head only if print quality declines; for example, if the printout is blurry or the color 

is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves 
ink.

❏ When ink is low you may not be able to clean the print head. When ink is expended you cannot 
clean the print head. Replace the appropriate ink cartridge first.
& See “Replacing an Ink Cartridge” on page 128.

Using the Head Cleaning Utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure the printer is turned on.

2. Make sure that no lights are indicating errors.

3. Make sure that letter/A4 size paper is loaded in the front paper cassette.

4. Right-click the printer icon on the taskbar, then select Head Cleaning.

If the printer icon does not appear, refer to the following section to add the icon.

& See “From the Shortcut Icon on the Taskbar” on page 15.

5. Follow the on-screen instructions.

The P Power light flashes while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P Power light is flashing. Doing so may damage the 
printer.

Note:
❏ If print quality has not improved after repeating this procedure, turn off the printer and wait for 

at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.

❏ If print quality remains a problem, contact Epson.
& See “Where To Get Help” on page 182.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.
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Using the Head Cleaning Utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure the printer is turned on.

2. Make sure that no lights are indicating errors.

3. Make sure that letter/A4 size paper is loaded in the sheet feeder.

4. Access the EPSON Printer Utility3.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Click the Head Cleaning button in the Utility dialog.

6. Follow the on-screen instructions.

The P power light flashes while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. Doing so may damage the 
printer.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the printer 

off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning 
if necessary. If print quality has still not improved, contact your dealer.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Control Panel (B-500DN)

Follow the steps below to clean the print head using the control panel.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
Menu appears on the LCD screen.

3. Press the d Down or u Up button to select MAINTENANCE, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select CLEANING, and then press the OK or 
r Right button.

5. Press the OK button to start cleaning. The P Power light begins flashing.
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c
Caution:
Never turn off the printer while the P Power light is flashing. Doing so may damage the 
printer.

6. When the P Power light stops flashing, the printer returns to the nozzle check menu. 
Press the OK button to print a nozzle check pattern to confirm that the head is clean.
& See “Checking the Print Head Nozzles” on page 137.

Note:
❏ If print quality has not improved after repeating this procedure, turn off the printer and wait for 

at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.

❏ If print quality remains a problem, contact Epson.
& See “Where To Get Help” on page 182.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Printer Buttons (B-300)

Follow the steps below to clean the print head using the printer buttons.

1. Make sure that no lights are indicating errors.

2. Make sure that letter/A4 size paper is loaded in the front paper cassette.

3. Press and hold down the H Ink button for three seconds.

The printer starts cleaning the print head and the P Power light begins flashing.

c
Caution:
Never turn off the printer while the P Power light is flashing. Doing so may damage the 
printer.

4. When the P Power light stops flashing, print a nozzle check pattern to confirm that the 
head is clean.
& See “Checking the Print Head Nozzles” on page 137.
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Note:
❏ If print quality has not improved after repeating this procedure, turn off the printer and wait for 

at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.

❏ If print quality remains a problem, contact Epson.
& See “Where To Get Help” on page 182.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to 
solve this problem by using the Print Head Alignment utility in your printer driver or from the 
printer by using the buttons.

Refer to the appropriate section below.

Note:
Do not press the + Cancel button (B-500DN) or the ) Paper/Cancel button (B-300) to cancel 
printing while printing a test pattern with the Print Head Alignment utility.

Using the Print Head Alignment Utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no lights are indicating errors.

2. Make sure letter/A4 size plain paper is loaded in the front paper cassette.

3. Right-click the printer icon on the taskbar, then select Print Head Alignment.

If the printer icon does not appear, refer to the following section to add the icon.

& See “From the Shortcut Icon on the Taskbar” on page 15.

4. Follow the on-screen instructions to align the print head.

Using the Print Head Alignment Utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no lights are indicating errors.

2. Make sure letter/A4 size paper is loaded in the sheet feeder.
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3. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

4. Click the Print Head Alignment button in the Utility dialog.

5. Follow the on-screen instructions to align the print head.

Using the Control Panel (B-500DN)

Follow the steps below to align the print head using the control panel.

1. Make sure that letter/A4 size plain paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
Menu appears on the LCD screen.

3. Press the d Down or u Up button to select MAINTENANCE, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select HEAD ALIGNMENT, and then press the OK or 
r Right button.

5. Press the OK button to print the alignment pattern.

6. Look at the alignment patterns and find the square without any visible bands in sets #1 
through #4.

7. Press the d Down or u Up button to select the number that corresponds to the square 
for sets #1 through #4.

8. Press the OK button to register your selection.

Cleaning Your Printer

To keep your printer operating at its best, clean it thoroughly several times a year.

w
Warning:
Be careful not to touch the parts inside the printer.
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c
Caution:
❏ Never use alcohol or thinner to clean the printer. These chemicals can damage the 

printer.

❏ Do not apply grease to the metal parts under the print head.

❏ Be careful to keep water away from the electronic components.

❏ Do not spray the inside of the printer with lubricants.

❏ Unsuitable oils can damage the mechanism. Contact Epson or a qualified service person 
if lubrication is needed.

Note:
After using the printer, close the paper support and the output tray to protect the printer from dust.

Cleaning the Inside of Your Printer

Ink and paper build-up from the rollers may affect the print quality or may prevent the paper 
from feeding smoothly. You can clean the inside of your printer using the control panel.

c
Caution:
Do not wipe the inside of the printer, or small pieces of lint may build up inside the printer.

Using the Control Panel (B-500DN)

Follow the steps below to clean the inside of the printer using the control panel.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
MENU appears on the LCD screen.

3. Press the d Down or u Up button to select MAINTENANCE, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select CLEANING SHEET, and then press the OK or 
r Right button.

5. Press the OK button. The printer feeds and ejects paper.

Repeat these steps until no ink gets on the paper.
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Using the Printer Buttons (B-300)

Follow the steps below to clean the inside of the printer using the printer button.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Press the ) Paper/Cancel button to feed and eject paper.

Repeat these steps until no ink gets on the paper.

Transporting Your Printer

If you need to transport your printer some distance, carefully prepare and repack it as 
described below. Use the original box and packing materials, or a similar box that holds the 
printer snugly.

c
Caution:
When transporting the printer, do not tilt it, stand it up vertically, or turn it upside down. 
Otherwise, ink may leak inside the printer.

1. Plug in the printer and turn it on. Wait until the print head returns to the home position.

2. Press the P Power button to turn off the printer, then unplug its power cord.

c
Caution:
Do not unplug the power cord while the print head is moving or the print head will not 
return to the home position.

3. Disconnect the interface cable.

4. Remove all paper from the printer.

5. Confirm that the cartridge lever is in the locked position and the cartridge cover is 
closed.

c
Caution:
Leave the ink cartridges and maintenance box installed to prevent the ink from leaking.

Note:
If you’re using the Extra High Capacity Ink Cartridge, install a standard- or high-capacity 
cartridge instead when you transport the printer.

6. Close the output tray and paper support.

7. Attach the protective materials to both sides of the printer.
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8. Repack the printer and power cord in the original box.

Note:
❏ Keep the printer level during transport.

❏ Be sure to remove the protective materials from the printer before using it again.

❏ Do not hold the duplex unit when you lift the printer, to prevent the duplex unit from becoming 
detached. Also, make sure that the duplex unit is attached correctly after setting up the printer.

Storing Your Printer

If you need to store your printer, follow the instructions below.

c
Caution:
When storing the printer, do not tilt it, stand it up vertically, or turn it upside down. Otherwise, 
ink may leak inside the printer.

1. Plug in the printer and turn it on. Wait until the print head returns to the home position.

2. Press the P Power button to turn off the printer, then unplug its power cord.

c
Caution:
Do not unplug the printer or turn off the power to the outlet until all the lights are off. 
Otherwise, the print head will not be capped and will dry out during long-term storage.

3. Disconnect the interface cable.

4. Remove all paper from the printer.

5. Confirm that the cartridge lever is in the locked position and the cartridge cover is 
closed.

c
Caution:
Leave the ink cartridges and maintenance box installed to prevent the ink from leaking.

6. Close the output tray and paper support.

Note:
You may need to clean the print head the first time you use the printer after storing it for a long 
period of time.
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Chapter 9 

Using the Printer on a Network

Setting Up the Printer on a Network (for B-500DN Users only)

This printer can connect anywhere on your network using 10Base-T or 100Base-TX 
because it has a built-in Ethernet interface that supports the TCP/IP protocol.

You can make network interface settings such as IP address by using the printer’s control 
panel, or the applications for your computer.

Using the printer’s control panel

& See “Network Setting Menu” on page 109.
& See also “How to Access the Control Panel Menus” on page 107.

Using the utilities for your computer

& See the network guide on the CD-ROM.

Setting Up Your Computers to Use the Printer

Make sure you have connected the printer to your network as described on the Start Here 
sheet. Then follow the steps below for every computer on the network that will print to the 
B-500DN.

1. Insert the Software CD-ROM in the CD-ROM drive.

With Windows Vista, if you see the AutoPlay window, click Run Epsetup.exe. When 
you see the User Account Control screen, click Continue.
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2. Click Easy Install.

3. Click Network.

4. Click the Install button and follow the on-screen instructions.

Note:
If the Windows Security Alert window appears, click the Unblock button; otherwise the printer 
will not be listed on the screen of EpsonNet EasyInstall.
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5. When you see the following screen, select the printer and click Next.

6. If you see the following screen, select Automatic. If you need to set the IP address 
manually, select Manual and enter the IP address, subnet mask, and default gateway. 
Then click Next. Follow the instructions on the screen to install the printer driver.
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7. When you see the following screen, enter a different name for the printer if you want. If 
you want to print a test page, select the Print test page check box. Click Next.

Note:
If the Windows Security Alert window appears, click the Unblock button.

8. Follow the instructions on the screen to complete the installation.

9. When you see this screen, click Finish. Then follow the instructions to register your 
printer.
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10.Click Exit and skip to step 12. Or, if you need to manage your network, click Back to 
return to the Easy Install screen.

11.Select Install Network Utility.
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12.Select each item to install.

Note:
EpsonNet Print is already installed; you don’t need to select it.

13.When you’re done, remove the CD and restart the computer.

Repeat these steps for every computer on the network that will print to the B-500DN.

Note:
❏ To find the supported OS versions for the printer, see the following section.

& See “Operating System Versions” on page 197.

❏ To find the bundled utilities, see the CD-ROM shipped with your printer.

❏ To get more information, see the Network Guide on the CD-ROM shipped with your printer.

Setting Up the Printer as a Shared Printer for Windows 
(B-300/B-500DN)

These instructions tell you how to set up your printer so users on the network can share it.

First you will set up the printer as a shared printer on the computer directly connected to it 
with a USB cable. This computer is the print server, and must stay powered on for the 
printer to be available to any computers on the network. Then you will add the printer to 
each network computer that will access it. Each computer is the print server’s client.

Note:
❏ These instructions are for small networks only. To share the printer on a large network, consult 

your network administrator.
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❏ To uninstall programs in Windows Vista, you need an administrator account and the password 
if you log on as a standard user.

❏ You must log on to a Computer Administrator account to install software on Windows XP. After 
you install Windows XP, the user account is set as Computer Administrator.

❏ You must log on to Windows 2000 as a user with administrative privileges (belonging to the 
Administrators group) to install software.

❏ When you use your printer as a shared printer on a network with the following combinations of 
computers, the client operating systems are not able to communicate with the printer, so that 
some functions are not available for that particular client.

❏ The illustrations in the following section are from Windows XP.

Setting Up the Print Server

Follow the steps below on the print server computer that is connected directly to the printer:

1. Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware 
and Sound category. (If the Control Panel is in Classic View, click Printers.)

Windows XP and Server 2003:
Click Start and select Control Panel, then select Printers and Faxes. (If the Control 
Panel is in Category View, click Printers and Other Hardware, then click Printers and 
Faxes.) 

Windows 2000:
Click Start, point to Settings, and click Printers.

2. Right-click the icon for your printer, then click Sharing. For Windows Vista, click the 
Change sharing options button and then click Continue.

3. Windows Vista, XP, and Server 2003:
Select Share this printer, then type a Share name.

Windows 2000:
Select Shared as, then type a name for the shared printer.

Server Client

Windows Vista/XP/Server 2003 Windows 2000

Windows 2000 Windows Vista/XP/Server 2003
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Note:
Do not use spaces or hyphens in the share name.

If you want Windows Vista, XP, Server 2003, and 2000 to automatically download 
printer drivers for computers that are running different versions of Windows, click 
Additional Drivers and select the environment and the operating systems of the other 
computers. Click OK, then insert the printer software CD into the CD-ROM drive.

4. Click OK or Close (if you installed additional drivers).

Setting Up Each Client

Follow these steps for each client computer on the network.

Note:
Your printer must be set up as a shared printer on the computer to which it is connected before you 
can access it from another computer.
& See “Setting Up the Print Server” on page 154.

1. Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware 
and Sound category. (If the Control Panel is in Classic View, click Printers.)
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Windows XP and Server 2003:
Click Start and select Control Panel, then select Printers and Faxes. (If the Control 
Panel is in Category View, click Printers and Other Hardware, then click Printers and 
Faxes.) 

Windows 2000:
Click Start, point to Settings, and click Printers.

2. Windows Vista:
Click the Add a Printer button.

Windows XP, Server 2003, and 2000:
Double-click the Add Printer icon. The Add Printer Wizard appears. Click the Next 
button.

3. Windows Vista:
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP:
Select A network printer, or a printer attached to another computer, then click 
Next.

Windows 2000:
Select Network printer, then click Next.

4. Follow the on-screen instructions to select the printer you want to use.
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Note:
❏ Depending on the operating system and the configuration of the computer to which the printer 

is connected, the Add Printer Wizard may prompt you to install the printer driver from the printer 
software CD-ROM. Click the Have Disk button and follow the on-screen instructions.

❏ To monitor the status of a shared printer, EPSON Status Monitor 3 must be installed on each 
computer. EPSON Status Monitor 3 is automatically installed when you install the printer 
software from the CD-ROM by using the Easy Install function.

Setting Up the Printer as the Shared Printer for Mac OS X

To set up your printer on a Mac OS X network, use the Printer Sharing setting. See your 
Macintosh documentation for details.

Note:
When your printer is shared on a Mac OS X network, the  EPSON Printer Utility3 icon does not 
appear in the Print window.

Note for Mac OS X 10.5:
When your printer is shared on a Mac OS X network, the Low Ink Reminder screen does not 
appear.
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Chapter 10 

Troubleshooting

Diagnosing the Problem

Troubleshooting printer problems is best handled in two steps: first diagnose the problem, 
then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided 
by online problem solving, the control panel, the EPSON Status Monitor utility, or by 
running a printer operation check. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printout problem not related to print 
quality, or a paper feeding problem, or if the printer does not print at all, refer to the 
appropriate section.

To solve a problem, you may need to cancel printing.
& See “Canceling Printing” on page 51.

Error Indicators

For B-500DN users
You can diagnose and solve most problems by checking the error messages on the LCD 
screen. If the printer stops working and displays a message on the LCD screen, refer to the 
section below to diagnose the problem, and then follow the recommended corrective 
measures.

& See “Status and Error Messages” on page 110.

For B-300 users
You can identify many common printer problems using the lights on your printer. If the 
printer stops working and the lights are on or flashing, refer to the section below to 
diagnose the problem, and then follow the recommended corrective measures.

& See “Status and Error Lights” on page 114.

Running a Printer Operation Check (for B-500DN Users)

If you are unable to determine the source of the problem, run a printer operation check to 
help you determine whether the problem comes from the printer or your computer.
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To run a printer operation check, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the interface connector of the printer.

3. Make sure that letter/A4 size paper is loaded in the front paper cassette.

4. Turn on the printer and make sure that READY appears on the LCD screen.

5. Press the r Right button to enter Menu mode.

6. Press the d Down or u Up button to display TEST PRINT, and then press the OK or 
r Right button.

7. Press the d Down or u Up button to display NOZZLE CHECK, and then press the OK or 
r Right button.

8. Press the OK button to start printing a nozzle check pattern.

A test page prints showing a nozzle check pattern. If the pattern has gaps, you need to 
clean the print head.
& See “Cleaning the Print Head” on page 139.

❏ If the test page prints, the problem probably lies in your software settings, the cable, or 
your computer. It is also possible that your software may not be installed correctly. Try 
uninstalling your software and reinstalling it.
& See “Uninstalling the Printer Software” on page 17.

❏ If the test page does not print, you may have a problem with your printer. Try the 
suggestions in the following section.
& See “The Printer Does Not Print” on page 177.

Running a Printer Operation Check (for B-300 Users)

If you are unable to determine the source of the problem, run a printer operation check to 
help you determine whether the problem comes from the printer or your computer.

To run a printer operation check, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the interface connector of the printer.

3. Make sure that letter/A4 size paper is loaded in the front paper cassette.
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4. Hold down the ) Paper/Cancel button and press the P Power button to turn on the 
printer. When the printer turns on, release both the buttons.

A test page prints showing a firmware version and a nozzle check pattern. If the pattern has 
gaps, you need to clean the print head.
& See “Cleaning the Print Head” on page 139.

❏ If the test page prints, the problem probably lies in your software settings, the cable, or 
your computer. It is also possible that your software may not be installed correctly. Try 
uninstalling your software and reinstalling it.
& See “Uninstalling the Printer Software” on page 17.

❏ If the test page does not print, you may have a problem with your printer. Try the 
suggestions in the following section.
& See “The Printer Does Not Print” on page 177.

Checking Printer Status

For Windows

Note:
When you use your printer as a shared printer on a network with the following combinations of 
computers, the client operating systems are not able to communicate with the printer, so that some 
functions are not available for that particular client.

Server Client

Windows Vista/XP/Server 2003 Windows 2000

Windows 2000 Windows Vista/XP/Server 2003
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Using the Progress Meter

When you send a print job to the printer, the progress meter appears, as shown in the 
illustration below.

The progress meter indicates the progress of the current print job and provides printer 
status information. This window also displays error messages as well as helpful tips for 
better printing. Refer to the appropriate section below.

Tips

Tips for getting the most out of your Epson printer driver appear in the text box of the 
progress meter window. A new tip appears every 15 seconds. For more details on the tip 
displayed in the window, click the Details button.
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Error Messages

If a problem occurs during printing, an error message appears in the text box of the 
progress meter window. For more detailed information, click Online Support to access 
Epson’s support website.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the printer status.

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer shortcut icon on the Windows taskbar. If the printer icon does 
not appear, refer to the following section to add the icon.
& See “From the Shortcut Icon on the Taskbar” on page 15.
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❏ Open the printer driver, click the Maintenance tab, then click the Status Monitor 3 
button.

When you access EPSON Status Monitor 3, the following window appears:

EPSON Status Monitor 3 provides the following information:

❏ Ink Status:
EPSON Status Monitor 3 provides a graphic display of the ink status. To see detailed 
information about the ink cartridges, click the Information button.

❏ Maintenance box Status:
EPSON Status Monitor 3 provides a graphic display of the maintenance box status.
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❏ Online Support:
You can access Epson’s support website from EPSON Status Monitor 3. If you 
encounter a problem, click Online Support in the EPSON Status Monitor 3 window.

For Mac OS X

Using EPSON StatusMonitor

If EPSON StatusMonitor detects a printer problem, it will inform you with an error message.

Follow these steps to access EPSON StatusMonitor.

1. Access the EPSON Printer Utility3.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.
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The Paper Jams

c
Caution:
Pull out the jammed paper gently. If you remove the jammed paper with force, torn pieces 
may stay inside the printer or the printer may be damaged.

1. For B-500DN users
Press the OK button to eject the jammed paper.

For B-300 users
Press the ) Paper/Cancel button to eject the jammed paper.

2. If the error does not clear, turn off the printer and remove all of the paper inside, 
including any torn pieces. Refer to the appropriate section below.

In the output tray:
Gently pull out the jammed paper forward.

Inside the printer:
Open the front printer cover, and then gently pull out the jammed paper forward.
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In the rear sheet feeder:
Gently pull out the jammed paper upward.

In the front paper cassette:
Close the output tray and pull out the front paper cassette. Then gently pull out the 
jammed paper forward.

Note:
❏ If you cannot pull out the front paper cassette, pull out the output tray first and remove all 

paper that is loaded in the front paper cassette.

Then pull out the front paper cassette and gently pull out the jammed paper forward.
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❏ After you remove the jammed paper and insert the front paper cassette, reinsert the output 
tray into the printer.

In the back of the printer:
Remove the duplex unit (B-500DN) or the upper rear printer cover (B-300) and open the 
lower rear printer cover. Then gently pull out the jammed paper.
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In the duplex unit:
Remove the duplex unit and open the cover of the duplex unit. Then, gently remove the 
jammed paper.

3. Close the printer cover and turn on the printer.

4. For B-500DN users
Reload the paper and press the OK button to resume printing.

For B-300 users
Reload the paper and press the ) Paper/Cancel button to resume printing.

Note:
If you cannot easily remove a foreign object, do not use force and do not disassemble the printer. 
Contact Epson for assistance.
& See “Where To Get Help” on page 182.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ You are using high quality paper.

❏ The printable side of the paper is face-up in the rear sheet feeder and face-down in the 
front paper cassette.

❏ The paper stack was fanned before loading.

❏ The paper is not loaded above the c arrow mark inside the edge guide.
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❏ The number of sheets in the paper stack does not exceed the limit specified for that 
paper.
& See “Paper Loading Capacities” on page 21.

❏ The left edge guide is snug against the left edge of the paper.

❏ The printer is on a flat, stable surface that extends beyond the base in all directions. 
The printer will not operate properly if it is tilted.

Print Quality Problems

If you are having print quality problems, then compare it with the illustrations below. Click 
the caption under the illustration that best resembles your printout.

Good sample Good sample

“Horizontal Banding” on page 170 “Vertical Misalignment or Banding” 
on page 170

“Horizontal Banding” on page 170 “Vertical Misalignment or Banding” 
on page 170
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Horizontal Banding

❏ Make sure the printable side of the paper is face-up in the rear sheet feeder and 
face-down in the front paper cassette.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 139.

❏ Use up ink cartridges within six months of opening vacuum package.

❏ For best print quality, use genuine Epson ink cartridges.

❏ Check the ink cartridge status.
& See “Checking the Ink Cartridge Status” on page 122.

If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 128.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 29.

Vertical Misalignment or Banding

❏ Make sure the printable side of the paper is face-up in the rear sheet feeder and 
face-down in the front paper cassette.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 139.

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head” on page 143.

❏ Clear the High Speed check box from the Advanced window in your printer driver 
(Windows). See the printer driver online help for details.

“Incorrect or Missing Colors” on 
page 171

“Blurry or Smeared Printout” on 
page 171
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❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 29.

Incorrect or Missing Colors

❏ For Windows, clear the Grayscale setting in the Advanced window in your printer 
driver.

For Mac OS X, change the Color setting to Color in Print Settings dialog in the Print 
dialog of your printer driver.

See the printer driver online help for details.

❏ Adjust the color settings in your application or in your printer driver settings.

For Windows, confirm the settings in the Advanced window.

For Mac OS X, confirm the settings in the Print Settings dialog from the Print dialog.

See the printer driver online help for details.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 139.

❏ Check the ink cartridge status.
& See “Checking the Ink Cartridge Status” on page 122.

If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 128.

❏ If your paper runs out, replace it as soon as possible. If the printer is left without paper 
for a long period of time, the colors of your next print job may be incorrect.

Blurry or Smeared Printout

❏ Use only paper recommended by Epson.
& See “Paper, Consumables, and Options” on page 187.

❏ Make sure the printer is on a flat, stable surface that extends beyond the base in all 
directions. The printer will not operate properly if it is tilted.

❏ Make sure your paper is not damaged, dirty, or too old.
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❏ Make sure your paper is dry and the printable side is facing up in the rear sheet feeder 
and facing down in the front paper cassette.

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 29.

❏ Remove each sheet from the output tray as it is printed.

❏ If you are printing on glossy media, place a support sheet (or a sheet of plain paper) 
beneath the stack, or load only one sheet at a time.

❏ Do not touch or allow anything to come into contact with the printed side of paper with 
a shiny finish. To dry your printouts, follow the instructions on the sheet packed with the 
paper.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 139.

Ink Bleeds Through the Page

❏ Use the Print Saturation Adjustment feature to reduce the amount of ink on the page 
and increase the drying time if necessary.
& See “Special Settings for Automatic Double-sided Printing (Using the Duplex Unit)” 
on page 59.

❏ Adjust the ink levels in the photo image.

Miscellaneous Printout Problems

Incorrect or Garbled Characters

❏ Turn off the printer and computer. Make sure the printer’s interface cable is securely 
plugged in.

❏ Clear the print job from the print queue.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.
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Incorrect Margins

❏ Confirm the margin settings in your application. Make sure that the margins are within 
the printable area of the page.
& See “Printable Area” on page 190.

❏ Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, confirm the settings in the Main Window.

For Mac OS X, confirm the settings in the Page Setup dialog or Print dialog.See the 
printer driver online help for details.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.

Printout Has a Slight Slant

Make sure that the paper is loaded into the front paper cassette or the rear sheet feeder 
correctly.
& See “Loading Paper” on page 22.

Inverted Image

❏ Clear the Mirror Image check box in the settings from your printer driver, or turn off the 
Mirror Image setting in your application.

For Windows, confirm the settings in the Page Layout window.

For Mac OS X, confirm the settings in the Print Settings dialog in the Print dialog.

For instructions, see the online help for your printer driver or for your application.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.

Blank Pages Print

❏ Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, confirm the settings in the Main window.

For Mac OS X, confirm the settings in the Page Setup dialog or Print dialog.
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See the printer driver online help for details.

❏ Confirm the Skip Blank Page setting from your printer driver.

For Windows, click the Speed & Progress button on the Maintenance window.

For Mac OS X, confirm the Extension Settings in the Print dialog.

If it is selected, blank pages in your data are not printed.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.

After trying one or more of these solutions, run a printer operation check to check your 
results.
& See “Running a Printer Operation Check (for B-500DN Users)” on page 158.
& See “Running a Printer Operation Check (for B-300 Users)” on page 159.

Printed Side is Smeared or Scuffed

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

❏ Clear the High Speed check box in the settings from your printer driver.

For Windows, confirm the settings in the Advanced window.

For Mac OS X, confirm the settings in the Print Settings dialog in the Print dialog.

See the printer driver online help for details.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 29.

Printing is too Slow

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 29.
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❏ For Windows, clear all customized settings and select Text as the Quality Option from 
your printer driver’s Main window.

For Mac OS X, clear all customized settings and select Automatic as the Mode and 
move the slider to Speed in the Print Settings dialog in the Print dialog of your printer 
driver. See the printer driver online help for details.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

❏ Close any unnecessary applications.

❏ If you print continuously for an extended period, the paper may temporarily stop feeding 
or the print head may pause for a while. This is to slow down the printing speed and 
prevent the printer mechanism from overheating and being damaged. If this happens, 
you can continue to print, but we recommend stopping and leaving the printer for about 
thirty minutes with the power on. (The printer does not recover with the power off.) After 
you restart, the printer will print at normal speed. 

❏ This printer checks the print head on a regular basis to keep the print head clean and 
to ensure you receive premium print quality. If the print head nozzles are clogged, the 
printer automatically cleans the print head. During self-checking, and during 
self-cleaning operation, the print speed may decrease.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.

If you try all of the methods above and cannot solve the problem, see the following:
& See “Increasing the Print Speed (for Windows only)” on page 179.

Paper Does Not Feed Correctly

Paper Does Not Feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with the paper for more 
information.

❏ The paper fits under the c arrow mark inside the edge guide.
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❏ The number of sheets in the paper stack does not exceed the limit specified for the 
media.
& See “Paper Loading Capacities” on page 21.

❏ Paper is not jammed inside the printer. If it is, remove the jammed paper.
& See “The Paper Jams” on page 165.

❏ You have followed all special loading instructions that came with your paper. Load the 
paper again.
& See “Loading Paper” on page 22.

Multiple Pages Feed

❏ Make sure the paper stack fits under the c arrow mark inside the edge guide.

❏ Make sure the left edge guide is snug against the left edge of the paper.

❏ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the 
opposite side before loading.

❏ Remove the stack of paper and make sure that the paper is not too thin.
& See “Paper” on page 189.

❏ Fan the edges of the stack to separate the sheets, then reload the paper.

❏ If too many copies of a file are being printed, confirm the Copies setting in your printer 
driver as follows, and also confirm in your application.

For Windows, confirm the Copies setting on the Page Layout window.

For Mac OS X 10.3 and 10.4, confirm the Copies setting in the Copies & Pages setting 
in the Print dialog.

For Mac OS X 10.5, confirm the Copies setting in the Print dialog.

See the printer driver online help for details.

Paper is Improperly Loaded

If you have loaded the paper too far into the printer, the printer cannot feed the paper 
correctly. Turn off the printer and gently remove the paper. Then turn on the printer and 
reload the paper correctly.
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Paper is not Ejected Fully or is Wrinkled

❏ Clear the jammed paper as explained in “The Paper Jams” on page 165. Also, check 
the Paper Size setting in your application or printer settings. See the online help for 
details.

❏ If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack 
of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Printer Does Not Print

All Lights Are Off

❏ Press the P Power button to make sure the printer is on.

❏ Turn off the printer and make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights Came On and then Went Out

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it 
immediately. Then check the label on the back of the printer.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact Epson.
& See “Where To Get Help” on page 182.

The Power Light is On

❏ If no buttons are pressed for 3 minutes, all lights other than the P Power light 
automatically turn off to save energy. Press any button (except the P Power button) to 
return the control panel to its previous state.

❏ Make sure the USB cable is securely connected to the printer and to your computer and 
check that the USB cable is not damaged or badly crimped.
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❏ If you are using the USB interface, make sure your cable meets the USB 1.1 or 2.0 
standards.

❏ If you are connecting the printer to your computer via a USB hub, connect the printer to 
the first-tier hub from your computer. If the printer driver is still not recognized on your 
computer, try to directly connect the printer to your computer without the USB hub.

❏ If you are connecting the printer to your computer via a USB hub, make sure the USB 
hub device is recognized by your computer.

❏ Turn off the printer and the computer, disconnect the printer’s interface cable, then print 
an operation check page.
& See “Running a Printer Operation Check (for B-500DN Users)” on page 158.
& See “Running a Printer Operation Check (for B-300 Users)” on page 159.

If the check page prints correctly, make sure the printer driver and your application are 
installed correctly.

❏ If you are trying to print a large image, your computer may not have enough memory. 
Try reducing the resolution of your image or printing the image at a smaller size. You 
may need to install more memory in your computer.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 17.
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Increasing the Print Speed (for Windows only)

You can increase print speed by selecting certain settings in the Speed & Progress 
window. Click the Speed & Progress button on your printer driver’s Maintenance window.



Troubleshooting 180

The following dialog box appears.

The table below lists the factors affecting print speed.

For more details on each item, see the online help.

Other Problems

Print Head Cleaning Does Not Start

❏ Make sure that no error indicator lights are on. If any error occurs, recover from the 
error status.
& See “Error Indicators” on page 158.

Print speed Faster Slower

High Speed Copies On Off

Always spool RAW datatype On Off

Page Rendering Mode On Off

Print as Bitmap On Off
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❏ Make sure that sufficient ink remains for printing. If the ink cartridge is expended, 
replace the cartridge.
& See “Replacing an Ink Cartridge” on page 128.

Color Ink is Consumed Even When Printing in Black Ink Only

Not only the black ink but also the color ink is consumed during the following operations: 
print head cleaning and self-cleaning.
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Appendix A 

Where To Get Help

Epson Technical Support

New :Only inkjet, SPC, and Scanner products are used in this section.Visit Epson’s support website for the Epson B-500DN or B-300 for solutions to common 
problems. You can download drivers and documentation, get FAQs and troubleshooting 
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

❏ Product name (Epson B-500DN or B-300)

❏ Product serial number (located on the back of the printer)

❏ Proof of purchase (such as a store receipt) and date of purchase

❏ Computer configuration

❏ Description of the problem

Then call:

❏ U.S.: (562) 276-7202, 6 AM to 6 PM, Pacific Time, Monday through Friday.

❏ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance 
charges may apply.

Purchase Accessories

New :Use Inkjet, SPC, and "other" products Only.(general)You can purchase genuine Epson accessories from an Epson authorized reseller. To find 
the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at 
http://www.epsonstore.com (U.S. sales) or http://www.epson.ca (Canadian sales).

http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=C11CA03091
http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=C11Ca03151
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Appendix B 

Product Information

Printer Parts

B-500DN

Front View

a. Edge guide: Holds your paper straight in the rear sheet feeder. Move it to the edge of your 
paper.

b. Rear sheet feeder: Feeds paper for printing.

c. Paper support: Supports the paper loaded in the rear sheet feeder.
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Rear View

d. Front printer cover: Covers the printing mechanism. Open only when the paper jams.

e. Print Head: Prints ink on your paper.

f. Control panel: Use the buttons and monitor the LCD screen and lights to control your printer. 
& See “Using the Control Panel” on page 103.

g. Maintenance box cover: Covers the maintenance box. Open only when replacing the 
maintenance box.

h. Output tray: Holds the ejected paper.

i. Front paper cassette: Holds your paper and feeds it for printing.

j. Cartridge lever: Locks the installed ink cartridges.

k. Cartridge cover: Covers the ink cartridges. Open when replacing the ink cartridges. When 
using the extra high capacity ink cartridge, leave opened.

a. USB connector: Connects the USB cable from your computer to the printer.

b. Ethernet connector: Connects the 10Base-T/100Base-TX cable from your computer to the 
printer.

c. Duplex unit: Supports automatic double-sided printing.

d. AC inlet: Connects the power cord.
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B-300

Front View

e. Rear printer cover: Covers the printing mechanism. Open only when the paper jams.

f. Air vents: Eject heated air from the printer.

a. Edge guide: Holds your paper straight in the rear sheet feeder. Move it to the edge of your 
paper.

b. Rear sheet feeder: Feeds paper for printing.

c. Paper support: Supports the paper loaded in the rear sheet feeder.

d. Front printer cover: Covers the printing mechanism. Open only when the paper jams.

e. Print Head: Prints ink on your paper.
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Rear View

f. Control panel: Use the buttons and monitor the lights to control your printer. 
& See “Using the Control Panel” on page 103.

g. Maintenance box cover: Covers the maintenance box. Open only when replacing the 
maintenance box.

h. Output tray: Holds the ejected paper.

i. Front paper cassette: Holds your paper and feeds it for printing.

j. Cartridge lever: Locks the installed ink cartridges.

k. Cartridge cover: Covers the ink cartridges. Open only when replacing the ink cartridges.

a. USB connector: Connects the USB cable from your computer to the printer.

b. Upper rear printer cover: Covers the printing mechanism. Open when attaching the duplex 
unit and when paper jams in the back of the printer.

c. AC inlet: Connects the power cord.

d. Lower rear printer cover: Covers the printing mechanism. Open only when paper jams.

e. Air vents: Eject heated air from the printer.
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Paper, Consumables, and Options

Paper

Epson offers specially designed paper and other print media for all your printing needs.

Note:
You can find the part numbers for the following Epson special papers on the Epson website.
& See “Epson Technical Support” on page 182.

Note:
The availability of paper varies by location.

Ink Cartridges

You can use the following ink cartridges with this printer:

Paper Size

Epson Bright White Paper Letter

Epson Premium Presentation Paper Matte Letter, Legal, 8 × 10

Epson Premium Presentation Paper Matte 
Double-sided 

Letter

Epson Presentation Paper Matte Letter, Legal

Epson Photo Quality Self-adhesive Sheets A4

Ink cartridge Part numbers

B-500DN B-300

Standard 
capacity

High capacity Extra High 
capacity

Black T6161 T6171 T6181 T6161

Cyan T6162 T6172 – T6162

Magenta T6163 T6173 – T6163

Yellow T6164 T6174 – T6164
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Maintenance Box

You can use the following maintenance box with the B-300 and B500DN:

Duplex Unit (B-300 Users only)

You can use the following duplex unit with the B-300.

Legal-size Paper Support

You can use the following legal-size paper support with this printer.

System Requirements

Windows Requirements

To use this printer, you must have any of the following Windows operating systems 
installed. For details on interfaces and operating systems, refer to the following table.

Part number

Maintenance Box T619000

Part number

Duplex unit C12C802531

Part number

Legal-size paper 
support

C12C815341

System PC Interface

Windows Vista, Windows XP, Windows 2000, 
and Windows 2003

USB 2.0 Host Driver by Microsoft must be used.

USB 1.0 and 2.0

Ethernet 100Base-TX/10Base-T (B-500DN only)
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Macintosh Requirements

To connect this printer to a Macintosh computer, you must have any of the following 
Macintosh operating systems installed. For details on interfaces and operating systems, 
refer to the following table.

Technical Specifications

Paper

Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer 

at any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always 
test samples of paper stock before purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. If you 
encounter problems, switch to a higher grade of paper.

❏ Use paper under normal conditions:
Temperature 59 to 77 °F (15 to 25 °C) 
Humidity 40 to 60% RH 

Single sheets:

System PC Interface

PowerPC-based or Intel-based Macintosh 
computers running Mac OS X 10.3.9 to 10.5.x

USB 1.0 or 2.0

Ethernet 100Base-TX/10Base-T (B-500DN only)

Size A4 (8.3 × 11.7 in., 210 × 297 mm)

4 × 6 in. (10 × 15 cm)

A6 (4.1 × 5.8 in., 105 × 148 mm)

Half Letter (5.5 × 8.5 in.)

 8 × 10 in. (20 × 25 cm)

16:9 wide size (4 × 7.11 in., 102 × 181 mm)

Letter 8 1/2 × 11 in.

Legal 8 1/2 × 14 in.

Paper types Plain bond paper or special paper distributed by Epson

Thickness
 (for plain bond 
paper) 

0.003 to 0.005 in. (0.08 to 0.11 mm)
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Envelopes:

Printable Area

Diagonal lines show printable area.

Single sheets: 

Envelopes:

Weight 
(for plain bond 
paper) 

64 g/m² to 90 g/m²

Size Envelope #10 4 1/8 × 9 1/2 in.

Paper types Plain bond paper

Weight 75 g/m² to 100 g/m²

A

C

B-L B-R

A

B-RB-L

C
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Note:
❏ Depending on the type of paper, print quality may decline in the top and bottom areas of the 

printout, or the area may be smeared.

❏ Automatic double-sided printing supports plain paper and Epson Bright White Paper only. 
Minimum bottom margin (C) is 0.63 in. (16 mm) when you use automatic double-sided printing.

Ink Cartridges

* Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C)

Note:
❏ We recommend that you use genuine Epson cartridges and do not refill them. The use of other 

products may affect your print quality and could result in printer damage.

❏ The printer ships with full cartridges and part of the ink from the first cartridges is used for 
priming the printer.

❏ Yields vary considerably based on images printed, print settings, paper type, frequency of use 
and temperature. For print quality, a small amount of ink remains in the cartridge after the 
"replacement cartridge" indicator comes on.

Minimum margin

Media type Single sheets Envelopes

A 0.12 in. (3.0 mm) 0.12 in. (3.0 mm)

B-L, B-R 0.12 in. (3.0 mm)  0.20 in. (5.0 mm)

C 0.12 in. (3.0 mm) 0.12 in. (3.0 mm)

Color Yellow, Magenta, Cyan, Black

Cartridge life Use within 6 months of opening the package.

Temperature Storage:
–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Freezing:*

8.6 °F (–13 °C) 
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Mechanical

* Loading capacity may decrease if the paper is curled.

Paper path Front paper cassette, rear sheet feeder

Loading capacity Front paper cassette
About 500 sheets of letter/A4 paper at 75 g/m²*

Rear sheet feeder
About 150 sheets of letter/A4 paper at 75 g/m²*

Using the optional legal-size paper support, about 60 
sheets of legal-size paper at 75 g/m²*

Output tray
About 170 sheets

Dimensions B-500DN

Storage

Width: 18.9 in. (480 mm)

Depth: 19.3 in. (489 mm)

Height: 12.3 in. (312 mm)

Printing

Width: 18.9 in. (480 mm)

Depth: 25.8 in. (656 mm)

Height: 14.6 in. (372 mm)

B-300

Storage

Width: 18.9 in. (480 mm)

Depth: 16.5 in. (420 mm)

Height: 12.3 in. (312 mm)

Printing

Width: 18.9 in. (480 mm)

Depth: 24.6 in. (624 mm)

Height: 14.6 in. (372 mm)

Weight B-500DN

Approx. 23.6 lb (10.7 kg) (without the ink cartridges)

B-300

Approx. 21.8 lb (9.9 kg) (without the ink cartridges)
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Electrical

B-500DN

Note:
Check the label on the back of the printer for its voltage.

B-300

Note:
Check the label on the back of the printer for its voltage.

100-120 V Model 220-240 V Model

Input voltage range AC 90 to 132 V AC 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7 A 0.4 A

Power 
consumption

Printing Approx. 32.0 W

(ISO/IEC10561 
Letter Pattern)

Approx. 32.0 W

(ISO/IEC10561 
Letter Pattern)

Ready mode Approx. 8.0 W Approx. 8.0 W

Sleep mode Approx. 4.5 W Approx. 5.0 W

Power off Approx. 0.3 W Approx. 0.6 W

100-120 V Model 220-240 V Model

Input voltage range AC 90 to 132 V AC 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7 A 0.4 A

Power 
consumption

Printing Approx. 30.0 W

(ISO/IEC10561 
Letter Pattern)

Approx. 30.0 W

(ISO/IEC10561 
Letter Pattern)

Ready mode Approx. 6.0 W Approx. 6.0 W

Sleep mode Approx. 3.0 W Approx. 3.5 W

Power off Approx. 0.3 W Approx. 0.6 W
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Environmental

* Without condensation

Standards and Approvals

U.S. model: 

European model: 

Australian model:

Interface

Temperature Operation:
50 to 95 °F (10 to 35 °C)

Storage: 
–4 to 104 °F  (–20 to 40 °C)

1 month at 104 °F (40 °C)

Humidity Operation:* 
20 to 80% RH

Storage:* 5 to 85% RH

Safety UL60950-1
CAN/CSA-C22.2 No. 60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

Low voltage directive 
2006/95/EC

EN60950-1

EMC directive 2004/108/EC EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024

EMC AS/NZS CISPR22 Class B

USB 2.0 Hi-Speed (Device Class for computers)

Ethernet 100BASE-TX/10 BASE-T (B-500DN only)
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Options

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

❏ Reorient or relocate the receiving antenna.

❏ Increase the separation between the equipment and receiver.

❏ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

❏ Consult the dealer or an experienced radio/TV technician for help.

Legal size paper support Width: 6.9 in. (176 mm)

Depth: .29 in. ( 7.4 mm)

Height: 4.3 in. ( 110 mm)

Weight: Approx. 1.5 oz ( 42 g )

Duplex unit (B-300 only) Width: 12.3 in. (313 mm)

Depth: 6.4 in. (163 mm)

Height: 3.6 in. (92 mm)

Weight: Approx. 1.98 lb (0.9 kg )
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WARNING

The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which 
exceed the limits established by the FCC for this equipment. It is the responsibility of the 
user to obtain and use a shielded equipment interface cable with this device. If this 
equipment has more than one interface connector, do not leave cables connected to 
unused interfaces. Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Operating System Versions

In this manual, the following abbreviations are used.

Windows refers to Windows Vista, XP, Server 2003, and 2000.

Macintosh refers to Mac OS X.

❏ Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium 
Edition, Windows Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista 
Ultimate Edition.

❏ Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and 
Windows XP Professional.

❏ Windows Server 2003 refers to Windows Server 2003 and Windows Server 2003 x64 Editions.

❏ Windows 2000 refers to Windows 2000 Professional.

❏ Mac OS X refers to Mac OS X 10.3.9 to 10.5.x.
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A

Accessories, purchasing, 182
Aligning print head, 143

B

Banding, 170
Blank pages, 173
Blurry prints, 171
Booklet printing, 72
Buttons and lights

B-300, 113
B-500DN, 104

C

Cable connector, 184, 186
Canceling printing

Mac OS X, 52
Windows, 51

Cartridge
checking status, 122
cover, 184, 186
lever, 184, 186
precautions, 126
purchasing, 126
replacing, 128 to 131

Cleaning
printer, 144
print head, 139

Color problems, 171
Contacting Epson, 182
Control panel

buttons and lights (B-300), 113
buttons and lights (B-500DN), 104
icons (B-500DN), 106
lights (B-300), 114
location, 184, 186
menu list (B-500DN), 107
message (B-500DN), 110
using B-300, 112 to 118
using B-500DN, 104 to 112

D

Documents, printing
Mac OS X 10.3 or 10.4 printer settings, 35
Mac OS X 10.5 printer settings, 33
Windows, 31

Double-sided printing
description, 56
folded booklet, 72
Mac OS X 10.3 or 10.4, 70
Mac OS X 10.5, 64
special settings in Windows, 59
Windows, 58

Driver
accessing for Mac OS X, 15
accessing for Windows, 14
uninstalling, 17

Duplex unit
automatic double-sided printing, 58
installing, 119
location, 184
part number, 188
specifications, 195
uninstalling, 120

E

Edge guide, 183, 185
Enlarging pages, 76
Envelopes

loading, 27
Mac OS X 10.3 or 10.4 printer settings, 50
Mac OS X 10.5 printer settings, 48
printable area, 190
printing, 46
Windows printer settings, 46

Epson
paper, 21
technical support, 182

Error indicators, 158
Ethernet connector, 184

Index
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F

Fit to page printing, 76
Folded booklet printing, 72
Front paper cassette

loading, 23
location, 184, 186

H

Head cleaning
B-300, 142
B-500DN, 141
Mac OS X, 141
Windows, 140

Help, Epson, 182
Horizontal banding, 170

I

Incorrect characters, 172
Ink cartridges

checking status in Mac OS X, 125
checking status in Windows, 122
part number, 187
precautions, 126
purchasing, 126
replacing, 128 to 131
specifications, 191

Interface cables, 194

L

Legal size paper support
installing, 119
part number, 188
specifications, 195

Lights
error indicators, 158
status and error, 114

Loading
envelopes, 27
front paper cassette, 23
paper, 21, 22, 23, 25
rear sheet feeder, 25

M

Mac OS X
accessing printer settings, 15
checking printer status, 164
status monitor, 164

Maintenance box
checking status (B-300), 132
checking status (B-500DN), 131
checking status in Mac OS X, 133
checking status in Windows, 132
cover, 184, 186
part number, 188
purchasing, 134
replacing, 135

Managing print jobs, 160
Margin problems, 173
Media Type, selecting, 29
Menu list

language, 108
maintenance, 108
network, 109
printer setting, 108
printer status, 108
test print, 108

Mirror image, 173
Misalignment, 170
Multiple pages per sheet, 84

N

Network printing
B-500DN, 148
Mac OS X, 157
Windows shared printer, 153 to 157

Nozzle check
Mac OS X, 137
Windows, 137

O

Operation check
B-300, 159
B-500DN, 158

Output tray
location, 184, 186
setting up, 29
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P

Pages per sheet printing, 84
Paper

Epson special paper, 21, 187
feeding problems, 175
loading, 22
loading capacity, 21
loading into front paper cassette, 23
loading into rear sheet feeder, 25
paper support, 183, 185
printable area, 190
selecting type, 29
specifications, 189
wrinkling, 177

Paper jams, 165
Part number

duplex unit, 188
ink cartridge, 187
legal size paper support, 188
maintenance box, 188

Posters
assembling pages, 96
printing, 92 to 97

Printable area specifications, 190
Printer

checking status, 160
cleaning, 144
front printer cover, 184, 185
operation check (B-300), 159
operation check (B-500DN), 158
rear printer cover, 185
rear printer cover (lower), 186
rear printer cover (upper), 186
transporting, 146

Printer settings
accessing for Mac OS X, 15
accessing for Windows, 14

Print head
aligning in Mac OS X, 143
aligning in Windows, 143
checking, 137, 139
cleaning, 139
location, 184, 185

Printing

canceling, 51
double-sided, 56
envelopes, 46
fit to page, 76
folded booklets, 72
multiple pages per sheet, 84
posters, 92 to 97
text, 31
watermarks, 97 to 102

Print quality, improving, 169
Print speed, increasing, 174, 179
Problems

banding, 170
blank pages, 173
blurry prints, 171
contacting Epson, 182
diagnosing, 158
incorrect characters, 172
incorrect colors, 171
ink bleeding through, 172
margins, 173
mirror image, 173
paper feeding, 175
paper jams, 165
printer does not print, 177
print speed, 174
smeared prints, 171, 174

Progress meter, 161

R

Rear sheet feeder
loading, 25
location, 183, 185

Reducing page size, 76
Replacing ink cartridges, 128 to 131
Resizing pages, 76

S

Safety information, 9
Service, 182
Shipping printer, 146
Smeared prints, 171, 174
Software

uninstalling, 17
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using, 14 to 20
Specifications

duplex unit, 195
electrical, 193
environmental, 194
ink cartridge, 191
legal size paper support, 195
mechanical, 192
paper, 189
standards and approvals, 194

Speed, increasing, 174, 179
Status Monitor

Mac OS X, 164
Windows, 162

Status sheet
B-300, 118
B-500DN, 112

System requirements, 188

T

Technical support, 182
Text

Mac OS X 10.3 or 10.4, 35
Mac OS X 10.5, 33

Text, printing documents, 31
Transporting printer, 146

U

USB connector, 184, 186
User's Guide, uninstalling, 19

W

Watermark printing, 97 to 102
Windows

accessing printer settings, 14
checking printer status, 160
managing print jobs, 160
status monitor, 162

status monitor, 162
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